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ABSTRACT 

Letian Lin: Fabrication, Structure and Properties of a Single Carbon Nanotube-Based 

Nano-Electromechanical System 

(Under the direction of Dr. Lu-Chang Qin and Dr. Sean Washburn) 

 

The research work evolved in this dissertation presents (i) a foundational study on 

the atomic structure, transport property, electromechanical actuation, and inter-shell 

friction of carbon nanotubes using a nano-electromechanical system based on a single 

carbon nanotube and (ii) a fabrication technique of the nano-electromechanical system 

which provides a versatile platform for studies on one-dimensional nano-materials such 

as nanowires or other types of nanotubes. The geometry of having a free suspended 

carbon nanotube makes the device capable of in situ electromechanical manipulation and 

electrical resistance measurement on a single nanotube in a transmission electron 

microscope.  

The fabrication and the operation of the device are first described in detail. 

Experimental results are then presented to report the electrical and mechanical properties 

of single nanotubes and corresponding device characterization. First, chiral indices of a 

nanotube and its corresponding electrical resistance at room temperature are measured. A 

physical model based on the band gap theory is established to correlate the electrical 

resistivity with the atomic structure of the carbon nanotube. Second, I present a direct 
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measurement of the torsional motion of both shells of a double wall carbon nanotube 

under an external torque on the outer shell. The measurement is performed by actuating a 

metal paddle attached to the outer shell of the nanotube while the stains of the nanotube 

are derived from its electron diffraction patterns. The inner shell is found to twist along 

with the outer shell with no stiction. The inter-shell friction, both static and kinetic, is 

inferred from direct measurements of each shell’s deformation, van der Waals 

interactions between the two shells, and a tested model of lattice strain. Finally, the 

handedness of carbon nanotubes is determined using the same device. The implications 

are also discussed for potential applications and as directions of future research. 
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Chapter 1  

Introduction 

 

 

 

1.1 Motivation 

Computer science and technology have experienced tremendous development in 

the past 65 years since the construction of the first computer. Without question, the 

integration and the miniaturization of electronic devices are one of the most basic and 

core achievements on computer development. It greatly affects the size, weight, power 

consumption, storage volume and computation power. The first decimal arithmetic 

computer based on vacuum tube, ENIAC, was built in 1945. It had a weight of 30,000 kg, 

a volume of 84 cubic meters, power consumption of 140 kilowatts and computation 

power of 5000 times per second. On the contrary, today’s laptop only has a weight of a 

couple of pounds, a volume less than 0.005 cubic meters, a power consumption less than 

100 watts and a computation power of 2.4 billion times per second.  The realization of 

this miniaturization is based on the advent of ultra large scale integrated circuit 

technology and the silicon technology. By using micron- and sub-micron lithography, 

electronic devices such as diodes and transistors are fabricated within an area of 0.03 
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square microns or even smaller on a silicon chip.  For example, an Intel microprocessor 

chip has about 200 million devices per square centimeters.  

But, we are also coming to the limit of today’s silicon technology after achieving 

fast progress on computer chips. The size of a device is limited by the following factors: 

(i) the wavelength of photons and refraction index in the immersion photolithography; (ii) 

the depletion of silicon, i.e. suppression of the free charge carrier concentration; (iii) the 

oxide thickness. Power consumption is another concern. Although the power 

consumption for any single device is small, the total amount goes up quickly when that is 

multiplied over an extremely large number. Furthermore, heating of electronic devices is 

a big problem. In the high ambient temperature ranges, devices often fail to work 

properly. All these factors will negatively affect the miniaturization of computer 

technology.  

In order to push the limit to a smaller dimension, people are seeking new 

materials with smaller size, less defective structure, lower power consumption and larger 

surface to volume ratio to dissipate heat. This comes to the length scale that is being 

studied by the present nanotechnology. Nano-materials, the dimension on the order of 

nanometers, are usually composed of one to tens of molecular layers in one dimension. 

On this level, the quantum effects are less masked by bulk effects and materials start to 

show different properties. Carbon nanotubes with diameters on order of nanometers and 

lengths from nanometers to millimeters, show unique electrically properties, which make 

them potential material for future computer technology. The subject of this thesis is 

fabrication of nanometer-scale electromechanical devices based on a suspended carbon 
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nanotube and exploration of the mechanical and electrical transport properties of the 

nanotubes.  

1.2 Structure of Carbon Nanotubes 

Carbon nanotubes have attracted tremendous amount of research interests from 

fundamental science and technological perspectives since they were first discovered by 

Iijima in 1991[1-3]. Due to their low dimensionality, carbon nanotubes possess a variety 

of intriguing properties which make them promising candidates for future technological 

applications [4-9]. They have already been used to build prototypes of next generation 

technology, including nano-transistors, metallic wires, electromechanical devices and 

displays [10-14]. People have suggested their use in everything from nano-electrical 

devices to space elevators.  Although these promising applications of carbon nanotubes 

may be somehow overestimated, the motivation and effort for the research on carbon 

nanotubes’ wide spread applications are worthwhile.  

To understand the atomic structure of a CNT, one can start from the structure of a 

graphene lattice [7], where the basis vectors 1a and 2a ( 1 2 0.246 nma a  )  are separated 

with an angle of 
060 , as shown in Fig. 1.2a. A single wall carbon nanotube can be 

obtained by rolling up a graphene about an axis perpendicular to the chiral vector A  to 

make the seamless hollow cylinder, illustrated in Fig. 1.2b. The chiral vector is defined 

by: 

1 2A ua va  ,                                                                             (1.2.1) 
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where u and v are integers and are called chiral indices. The perimeter of a CNT is the 

magnitude of the chiral vector 2 2 1/2

0( )A a u v uv   , and the diameter of the nanotube is 

/ 2dR A  . The translational vector  c  of the nanotube perpendicular to the chiral vector 

is defined as: 

1 2c ma na   ,           (1.2.2) 

where m and n are integers. By applying the orthogonality relationship between the chiral 

and translational vectors ( 0A c  ), m and n can be calculated as 

2 2
, 

u v u v
m n

M M

 
   ,         (1.2.3) 

where M is the greatest common divisor of (2u+v) and (u+2v). Thus the periodicity of 

the nanotube is given in the form of: 

2 2

03 3a u v uv A
c

M M

 
   .        (1.2.4) 

The angle between the lattice vector 
1

a  and chiral vector A  is called helical angle 

(helical angle) and is given by  

 
3

arctan
2

v

v u


 
    

.          (1.2.5)  

The helical angle of a carbon nanotube lies in the range of [0°, 30°] if the handedness of 

the tube is ignored (     ). Within this range, carbon nanotubes come in two 

different groups of symmetry: non-helical and helical nanotubes. For helical nanotubes, 

the helical angle lies in the range of (0°, 30°). For the non-helical nanotubes, they are two 
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special cases. When        , i.e. α=0°, the nanotube is called zigzag. The other is 

called armchair nanotube when u=v, i.e. α=30°. 

A multiwall carbon nanotube consists of multiple rolled-up graphene sheets.  All 

the graphene sheets form concentric cylinders in a MWNT with an interlayer distance 

close to 0.34 nm. People can use the same parameters, i.e. chiral indices and helical angle, 

to describe the structure of each layer in a MWNT.  

 

 

Figure 1.2 (a) Schematic of a graphene lattice structure with basis lattice vectors 
1

a and 

2a . The shadowed rectanglar area is the radial projection of a carbon nanotube (7, 1) on 

the graphene sheet. ,  and A c  are the chiral vector, helical angle and translational 

vector of the nanotube. (b) Schematic structure of carbon nanotube (7, 1) when it is rolled 

up perpendicular to the chiral vector A to form a hollow cylinder. Adapted from [7]. 
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1.3 Mechanical Properties of Carbon Nanotube  

Carbon nanotubes are one of the strongest materials. This property is attributed to 

the sp
2
 bonds shared by carbon atoms in the nanotube. Each atom is covalently bonded to 

the three nearest neighbors and this results in a robust structure. A SWNT is predicted to 

have a Young’s modulus of ~1 TPa and a shear modulus of ~0.5 TPa by theory [5, 15]. 

The values of a MWNT may be different from each other, dependent on the number of 

layers, but theoretical work has suggested that a MWNT should have a Young’s modulus 

above 1.1 TPa and a shear modulus above 0.55 TPa [5]. 

Many experimental work reports on the measurement of these values in the past 

decade [15-31]. Scanning tunnel microscope, atomic force microscopy, transmission 

electron microscopy and scanning electron microscopy have been extensively used in 

these experiments and the results are roughly same magnitude of the theoretical values. It 

remains a challenge in experiment to measure accurately the chiral indices (u,v) of a 

carbon nanotube and the mechanical properties of the same carbon nanotube. A technique 

to measure shear modulus and chiral structure of a free standing nanotube simultaneously 

will be described in Chapter 3 and the experimental results will be discussed in great 

detail in Chapter 5. 

Furthermore, the weak van der Waals interactions between the neighboring layers 

in a MWNT make it easy to trigger a relative motion between different layers [32-39]. 

Experiments demonstrated that nanotubes exhibit little or no signs of wear or fatigue 

despite the large amount of the repetition of this motion due to the robustness of each 

carbon layer [10, 30, 40]. This unique property has stimulated a lot research work on 



7 
 

theoretical interlayer interaction models, experimental measurement on interlayer 

interaction and fabrication of carbon naotube based nano-electromechanical devices like 

nano-scale motors, springs or switches [14, 28, 30, 41-43]. Previous experimental work 

has been unable to directly measure the interlayer correlation in a MWNT under a 

torsional stress. In Chapter 5, direct measurements on the interlayer friction and inner-

shell torsional response to the shear stresses applied to the outer-shell will be discussed in 

detail.  

1.4 Electronic Properties of Carbon Nanotube 

Because carbon nanotube is formed by rolling up a two-dimensional graphene 

sheet into a seamless cylinder, the electronic band structure of a CNT is closely related to 

that of a graphene sheet. Each carbon atom in a graphene structure has six electrons: two 

1s electrons, three 2sp
2
 electrons and one 2p electron. The three 2sp

2
 electrons form three 

covalent bonds to bond the carbon atom to the 3 nearest neighbors in the graphene plane. 

The one 2p electron forms an unsaturated  orbital which perpendicular to the graphene 

plane. Combining the tight-binding model and Bloch wave function, the energy 

dispersion relationship of a graphene sheet can be obtained in the following form [11]: 

23 3 3
1 4cos( )cos( ) 4cos ( )

2 2 2
pp y y xE V k a k a k a    ,     (1.4.1) 

where 
ppV 

 is tight binding parameter for   orbital (2.9 eV for graphene) and a is the 

lattice constant (a=0.246 nm). The covalent and conduction bands meet at six points

4
( ,0)

3 3a


 , 

2 2
( , )

33 3 aa

 
  at the corners of the first Brillouin zone.  This energy band 
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structure has a non-zero density of states at the Fermi level, but the Fermi surface only 

consists of points, as shown in Fig. 1.4.1. Thus, graphene is called a semi-metal.  

 

 

Figure 1.4.1 Electronic structure of graphene calculated basing on the tight-binding 

model with only  orbitals concerned.  Adapted from [11]. 

 

When the graphene sheet is rolled up to form a CNT, this  orbital is still 

perpendicular to the nanotube surface and forms a delocalized   network across the 

nanotube, which is responsible for the nanotube electronic properties. But the wave 

vector now is quantized in the circumferential direction [44]: 

2x x y yk A k k A xA      ,         (1.4.2) 
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where     is the waver vector,    is the chiral vector and x is an integer. As a result, CNT 

can be either metallic or semiconducting, depending on whether or not the allowed wave 

vectors by Eqn. 1.4.2 pass through any pair of the 6 graphene Fermi points, as illustrated 

in Fig. 1.4.2. Fig. 1.4.3 illustrates the examples of band structures for a semiconducting 

and a metallic zigzag CNTs. This leads to an equivalent condition for metallic CNT: 

3u v g  , g is an integer. The theoretical linear conductance of a metallic CNT in low 

bias transport is given by [11] 

24 1

6.5 Ω

e
G

h k
  ,          (1.4.3) 

when the condition 3u v g   is not satisfied, the CNT is semiconducting and the 

energy gap is given by [45] 

 
2

d

cos 3α0.4
(1 ) [1 ( 1) ]

R

pp p

g

d d

V
E

R R


    ,        (1.4.4) 

Where 
ppV   is the tight-binding parameter for the  orbital, 

dR  is the CNT radius divided 

by 0.142 nm, p is the reminder of 
3

u v
,  is the helical angle of CNT, and 0.4   is a 

constant dependent on ratio of the tight-binding parameter   orbital to that of the 

orbital. As we can see from the Eqn. 1.4.4, the radius of CNT plays a dominant role in the 

energy gap when the radius is large. But the chiral structure of CNT starts to affect the 

energy gap if the nanotube radius is small and thus affects the electric resistance of the 

CNT. This subject will be discussed in great detail in Chapter 4.  
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Nanotubes are seldom in their perfect structures when measured in experiments. 

Interactions with metal contacts or substrate causes structural deformation and induce 

significant   coupling, stretching and compression of bonds, all of which affect 

CNT’s electronic properties. Theoretically, the response of the change of band gap to a 

torsional stain is given in the following form [46]: 

  2 1 3 ( )
gdE

sgn p tsin
d




   ,        (1.4.5) 

where   is the strain and t is the tight-binding overlap integral 2.77 eV. Clearly in Eqn. 

1.4.5, the response is sensitive to the chiral structure of nanotubes.  

 

 

Figure 1.4.2 Illustration of allowed wave vector, shown as bold line, in a 2D Brillouin 

zone of graphene. Only when the wave vectors go through the vertices of the Brillouin 

zone, the CNT is metallic as shown in the right figure. Otherwise the CNT is 

semiconducting, shown in the left figure. Adapted from reference [11]. 
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Figure. 1.4.3 Illustration of the band structure of a semiconducting (left) and metallic 

zigzag CNTs. Adapted from reference [11]. 

 

1.5 Outline 

Chapter 2 of this thesis will concentrate on the techniques of CNT 

characterization. STM and Raman Spectroscopy will be introduced briefly. CNT imaging 

by transmission electron microscope and determination of CNT chiral structure by nano-

beam electron diffraction patterns will be described in detail in this chapter. In Chapter 3, 

device fabrication techniques will be presented. The procedure of how to make 

suspended carbon nanotube nano-electromechanical devices will be the main topic. The 

design and fabrication of a customized TEM sample holder which is used for in situ TEM 

imaging and electronic measurement is described in the last section of this chapter. 

Chapter 4 discusses the resistance of SWNT and DWNT with known chiral indices. 

Chapter 5 focuses on the interlayer interactions of a DWNT under an external torsional 

stress. The use of a suspended CNT nanoelectro-mechanical device to apply an external 

strain on a DWNT as electron diffraction patterns being taken on the DWNT is 

demonstrated. Chapter 6 discusses how to reveal handedness of a CNT by analyzing the 
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shift of diffraction patterns under torsional strain. Finally, Chapter 7 summarizes the 

thesis and discusses future directions and other uses of the devices. 
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Chapter 2  

 

Characterization Techniques for Carbon 

Nanotubes 

 

 

 

Identification of the atomic structures of carbon nanotube has been on the center 

stage of research ever since the nanotubes were discovered. Many techniques have been 

developed and applied to characterize CNT structure including transmission electron 

microscopy (TEM), scanning tunneling microscopy (STM), scanning electron 

microscopy (SEM), atomic force microscope (AFM), X-ray diffraction (XRD), Raman 

spectroscopy, optical absorption spectroscopy, and nuclear magnetic resonance (NMR). 

So far TEM has been the most popular and powerful technique for characterizing CNT 

structure although STM, Raman spectroscopy and optical absorption spectroscopy are 

also widely used for elucidation of the CNT atomic structure. Due to various limitations 

of their probing methods, the later three techniques still have formidable difficulties on 

obtaining accurate atomic structure compared to TEM.  
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2.1 Scanning Tunneling Microscopy (STM) 

Scanning tunneling microscope is a non-optical surface imaging instrument with 

atomic precision invented in 1981. The invention won its inventors Gerd Binning and 

Heinrich Rohrer, the Nobel Prize in Physics in 1986. A STM can have a lateral resolution 

of 0.1 nm and a depth resolution of 0.01 nm. Within such a high resolution, the outermost 

atoms on surface can be routinely imaged.  

The working principle and high resolution capability of STM are based on the 

concept of quantum tunneling. When the metal probe of a STM is brought very close to 

sample surface (usually about 
o

4 7 A ) with a voltage bias applied between the probe tip 

and surface, electrons will tunnel through the vacuum between them and form a tunneling 

current. This current is a function of the separation distance between tip and surface, bias 

voltage, tip radius and local density of states of the surface. Morphological information is 

acquired through monitoring the tunneling current when the probe is scanning across the 

surface. The local density of states can be derived from the differential conductance 

calculated from tunneling current and bias voltage curve. The surface morphology thus 

can be reconstructed based on the local density of states.  

Experiments [1-3] by STM and scanning tunneling spectroscopy (STS) have been 

reported on the characterization of SWNT’s atomic structure as well as electronic 

structure. Fig. 2.1.1 shows a high resolution STM image of a SWNT, in which the lattice 

of black dots are attributed to the centers of the hexagons [1]. The dashed line and the 

solid line represent the tube axis and the zigzag direction, respectively. The angle 

between the two lines is the helical angle from which chiral indices (u, v) of the SWNT 

can be derived if the tube diameter is known. The diameter can be measured by 
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estimating the line profiles perpendicular to the tube axial direction. An accuracy of 1

in helical angle and 0.1 nm  in diameter measurement can be obtained and this allows 

for an identification of the chiral structure. Besides the atomic structure of a SWNT, the 

SWNT’s band gap can also be derived from the conductance calculated from an I-V 

curve measured by STM.  

STM is a very powerful characterization tool in the sense that the atomic structure 

and the electronic properties can be investigated simultaneously. But the structure 

deformation [4, 5] resulted from interactions between a SWNT and the substrate may 

induce errors in structure characterization by STM, especially when the diameter of a 

SWNT is larger than a couple of nanometers. Existing STM studies on MWNTs show 

that STM resolves the charity and the electronic properties of outer shell only. The effects 

of the inner shells on the electronic spectroscopy of MWNTs are very weak [6]. 

Therefore, STM technique is not able to detect the atomic structures of inner shells in 

MWNT. In 2007, Giusca et. al. demonstrates that the chirality of the inner shell in a 

DWNT can be obtained from the STS measurement combined with calculated local 

density of states [7]. However, the method to derive inner shell information works only in 

certain combinations of inner and outer shells and thus is not a universal method for all 

DWNTs.  
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Figure 2.1.1 Atomically resolved STM image of an individual SWNT. T, H and  are the 

tube axis, zigzag direction and helical angle, respectively. The lattice of black dots 

represents the centers of the hexagons. Adapted from reference [1]. 

 

2.2 Raman Spectroscopy 

Raman spectroscopy is a widely used technique for the study of vibrational, 

rotational, and other low frequency modes in materials. The basic principle of Raman 

spectroscopy is the concept of Raman scattering of monochromatic light which is usually 

comes from lasers in the visible, near infrared and near ultraviolet range. The interactions 

between photons of the laser and molecular vibrations, phonons or other excitation modes 

in the system will shift the laser photons’ energy up and down. The information about 

phonon modes in the system can be obtained from this energy shift.  

The diameter dependence of vibrational mode frequencies and the electronic 

structure of carbon nanotubes can be studied by Raman spectroscopy. Raman scattering 

occurs when the energy of incident laser photons matches one inter-band electronic 

transition energy of a carbon nanotube. A typical Raman spectrum of a SWNT has two 

sharp peaks corresponding to the radial breathing mode (RBM) and the graphitic mode 

(also called G-band), respectively [8]. The RBM mode, where all carbon atoms move in 

phase in radial direction, is a low frequency vibration mode and very sensitive to the 
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diameters of the nanotubes but not their helicities. The peaks are located between 120 

-1cm and 350 -1cm , respectively. The frequency of RBM mode is usually used to 

determine the diameter of a SWNT and is given by 

RBM

A
w B

d
                      (2.2.1) 

where d is tube diameter, A (unit: -1cm nm ) and B (unit: -1cm ) are constants  and vary 

between individual SWNT and SWNT bundles. A and B have been found to be 248 

-1cm nm  and 0 -1cm  for isolated SWNTs on Si/SiO2 substrate [9].  

The diameter alone is not enough to identify the chirality of a SWNT. The second 

parameter needed is the transition energies of inter-bands which can be obtained from 

resonant Raman scattering (RRS). A plot of transition energies of all chiral structures 

calculated from tight-binding model should be compared with those obtained from RRS 

experiments. With the tube diameter, the chiral indices can be determined by a match 

between theoretical and measured transition energies [10].  

As we can seen from Eqn. 2.2.1, Raman spectroscopy is a tool very sensitive to 

nanotube diameters (<2 nm). The RBM signals become very weak and are broadened for 

SWNT with large diameter and MWNTs.  This is because that the curvature of CNT has 

less influences and the Raman spectra resemble to that of graphene when the diameter is 

large. However, the innermost shell of a MWNT still shows strong RBM modes in the 

spectra and the chiral indices of the shell can be determined by Raman spectroscopy 

because of its small inner diameter (< 2 nm) [11, 12]. 
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2.3 Optical Absorption Spectroscopy 

Optical absorption spectroscopy refers to the technique which measures the 

absorption spectrum of a material when the material is exposed to light (usually the light 

source covers a broad swath of wavelengths from infrared to ultraviolet). If the incident 

wavelength matches certain transition energy, the photon will be absorbed and the 

material will transit to an excited state. Emission occurs a photon with energy equal to the 

energy difference between the ground state and excited state. Therefore, the absorption 

spectrum of a material can be calculated from its emission spectrum using appropriate 

theoretical models and additional information about the quantum mechanical states of the 

substance. The inter-band transition energies and electronic structure of SWNTs can be 

studied by optical absorption spectroscopy based on the principle mentioned above. In an 

optical absorption spectroscopy measurement, SWNTs are usually well dispersed in a 

solution and show high energy-resolution in their optical absorption spectrum. The 

method to indentify the chiral indices of SWNTs is similar to that of Raman spectroscopy 

mentioned in last section [13-16].  

The disadvantage of optical absorption spectroscopy is that it is hard to 

characterize the structure of a MWNT. It is also difficult to identify the structure of a 

single SWNT because of the weak signal.  

 

2.4 Transmission Electron Microscopy and Electron Diffraction 

Transmission electron microscopy is a powerful tool for microstructure and 

nanostructure characterization. It is a microscopy where fast electrons go through a very 

thin specimen, interacting with the atoms in the specimen as electrons pass through. 
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Scattered electrons are focused to form a magnified image onto an imaging device such 

as a fluorescent screen, a photographic film, or a sensor such as a CCD camera. The 

physical principles behind the development of TEM should be attributed to the following 

two aspects: (1) the wave-like characteristics of electrons first postulated by Louis de 

Broglie in 1925 [17]; (2) the discovery of electron focusing lenses which use 

electromagnetic field to focus moving electrons in desired direction by Hans Busch in 

1926 [18]. The first transmission electron microscope was built by Ernst Ruska and Max 

Knoll in 1932 [19]. Ernst Ruska shared the Nobel Prize in Physics with Gerald Binning 

and Hans Rohrer in 1986. The wavelength of an electron accelerated by a voltage 

between 100 kV to 400 kV is about two orders magnitude smaller than the size of an 

atom which has a diameter of about 0.1 nm. In principle, it is possible to resolve material 

structure well below the atomic level according to the Raylaigh criteria [20]. However, a 

TEM with this resolution limit is impossible to construct due to the imperfections of the 

magnetic lenses. Nowadays, a good TEM can achieve the resolution on the order of 0.1 

nm. In contrast, electron diffraction is much less sensitive to the imperfections of 

magnetic lenses, but more dependent on the convergence of incident electrons [21]. 

Within this research, CNT images and electron diffraction patterns are taken on 

JEM 2010F FasTEM electron microscope (vender JEOL). All the diffraction patterns are 

taken by the nanobeam electron diffraction method with beam waist of about 80 nm. 

2.4.1 Theory of Electron Imaging in TEM 

A TEM produces an image in the following two-step Abbe principle: (1) the 

incident electrons are scattered by the specimen and form a diffraction pattern on the 

back focal plane of the objective lens; (2) the scattered electrons are recombined to form 
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an image on the image plane. Two imaging mechanisms are usually used: amplitude 

contrast and phase contrast [22]. In the amplitude contrast mode, the image contrast is the 

result from the electrons scattered in different angles within a specimen. The areas of the 

specimen with higher mass or larger Coulomb potential will scatter more electrons 

toward large angular regions which are away from optical axis. If a small aperture is used, 

most electrons which are scattered in large angles can be excluded except the selected 

beam. As a result, the areas corresponding to the higher mass or strong atomic potential 

positions within the specimen will turn dark in the image. On the other hand, image 

contrast in the phase contrast mode comes from the phase difference of electrons caused 

by interactions between electrons and the Coulomb potential of the specimen. A large 

objective aperture is usually used to allow more scattered beams to pass through the 

objective lenses to form an image. It offers a much higher structural resolution and is 

usually called high resolution TEM compared to the amplitude contrast mode. But it 

requires that the specimen be thin.   

Like the image formation in an optical microscope, the scattered electron waves 

in the diffraction plane will form a two-dimensional structure image projected from three-

dimensional specimen on the image plane. However, in order to better interpret the 

electron imaging process, both non-linear imaging and dynamical electron diffraction 

effects need to be considered [23]. 

For phase contrast imaging, the interactions between the incident electrons and 

the specimen are usually weak and theories can be greatly simplified. In the phase-grating 

approximation, the wave function of the electron scattered by specimen can be described 

by [24] 
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( , ) ( ,x )e p po ix y x yV     ,                (2.4.1) 

where / ( )U    is the relativistic interaction constant with U being the accelerating 

voltage applied on electrons, ( , )pV x y  is the projected Coulomb potential of specimen in 

a plane perpendicular to the direction of the incident electron beam and  is the wave 

length of the electrons. For a thin specimen constituted of light atoms, the weak phase 

object approximation can be applied and Eqn. 2.4.1 can be simplified to 

( , ) 1 ( , )o x y i V x y   ,         (2.4.2) 

where the unit 1 represents the transmitted wave which has no interaction with the 

specimen and the imaginary part corresponds to the scattered waves. The image wave on 

the image plane is a convolution between the object wave and a contrast transfer function 

     : 

( ) ( ) ( )i or r T r   ,         (2.4.3) 

where   is the convolution operator. The convolution operation of two functions can be 

expressed as the product of their corresponding Fourier transforms in the reciprocal space: 

( ) ( ) ( )i oq q T q   .         (2.4.4) 

The contrast function in a TEM includes the information of aperture function, spherical 

aberration and imperfection of focusing of the objective lens and is given by [25] 

( ) ( )exp[2 ( )]T q a q i q  ,         (2.4.5) 

where ( )a q  is the aperture function of the objective lens and  

4 21 1
( )

4 2
sq C q fq    ,         (2.4.6) 
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where sC  and Δf are the spherical aberration coefficient and defocus of the objective 

lens, respectively. Using Eqn. 2.4.5 and 2.4.6, Eqn. 2.4.3 can then be expressed as 

( , ) 1 ( , ) [ ( , )] ( , ) [ ( , )]i p px y V x y Im T x y i V x y Im T x y       .    (2.4.7) 

In weak phase object approximation, 1pV , the image intensity can then be further 

simplified into 

2

i( , ) | Ψ | 1 2( ( , ) [ ( , )], ) pI x y V x y Im T xx y y    .      (2.4.8) 

Eqn. 2.4.8 shows that only the imaginary part of the contrast transfer function contributes 

to the image intensity in the weak phase object approximation and linear imaging. 

2.4.2 TEM Imaging of CNT 

Because CNTs are formed by graphene layers and carbon atoms have a low 

atomic number (    ), the weak phase object approximation discussed in the last 

section can be used to interpret the TEM images of carbon nanotubes structure (an image 

actually corresponds to the projected Coulomb potential of the CNT [26]). A high 

resolution TEM equipped with a field emission electron gun can easily obtain structural 

images of a CNT with a resolution of about 0.2 nm. Thermal and mechanical vibrations, 

stage drift, and instabilities of the magnetic lenses will compromise the quality and the 

resolution of a TEM image. 

Fig. 2.4.1 shows high resolution TEM images of a SWNT, a DWNT and a six-

wall carbon nanotube. Hollow cylinder structure of the carbon nanotubes is seen clearly 

in the images. In the DWNT and the six-wall carbon nanotubes, two and six concentric 

cylinders can be identified in the figure. The two parallel darks lines run along the tube 

axis are the projected structure of the tube walls. The diameter of the nanotube can be 
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measured from a line profile perpendicular to the tube axis. But the measurement needs 

to be very careful because the position and width of the dark line are very sensitive to the 

imaging condition such as the defocus of the objective lens. It also causes errors in the 

diameter measurement if the nanotube is not oriented within a horizontal plane, i.e. not 

perpendicular to incident beam. The error becomes more significant when measuring the 

smaller diameter tube due to the pronounced curvature [27]. 

 

 

Figure 2.4.1 TEM images of (a) SWNT, (b) DWNT, and (c) 6-wall carbon nanotube 

taken with JEM 2010F operated at 80 kV.  

 

 

2.5 Electron Diffraction Theory of Carbon Nanotube 

The kinematical theory of electron diffraction is used to understand the diffraction 

patterns of carbon nanotubes because carbon atoms have a small scattering amplitude for 

fast incident electrons. A brief understanding of electron diffraction from CNT could start 
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from the diffraction pattern of graphene. Since carbon nanotubes are formed from 

graphene, they share some features in the diffraction patterns: diffraction layer lines 

resulting from the honeycomb lattice of graphite have a well-defined periodicity in the 

tube axial direction. But the structure in the radial direction is not periodic in a CNT 

when the graphene is rolled along the chiral vector to form a nanotube. As a result, the 

reflections are sharply defined along tube axis but elongated perpendicular to the tube 

axis. 

A complete CNT electron diffraction theory was formulated by Qin in 1994 [28] 

and Lucas et al. in 1996 [29, 30] based on the kinematical theory of scattering from 

helical structure developed by Cochran, Crick and Vand in 1952 [31]. The theory has 

been proved to be powerful in characterization of carbon nanotube’s chiral structure. 

The atomic scattering amplitude for electrons incident on atoms are described by the first 

Born approximation [30] 

   2

2
( )exp 2

me
F q v r iq r dr

h


  ,       (2.5.1) 

where ( )v r  is the Coulomb potential of the scattering atom, e is the charge of an electron, 

  is the relativistic mass of electron,  is Plank’s constant and    is the scattering vector 

with the magnitude defined as 

2sin(Θ / 2)
q


 ,          (2.5.2) 

where Θ  is the total scattering angle and   is the wave length of the incident electron.    

The diffraction intensity distribution ( )I q  in reciprocal space is the square of the 

scattering amplitude  

  2| ( ) |I q F q .          (2.5.3) 
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Since the atoms of a CNT are periodically located on a pair of helices about the tubular 

axis, we start the derivation of diffraction patterns from the scattering amplitude of a 

continuous helix, which is expressed in the cylindrical coordinates for the convenience: 

1

1
( , , ) exp[ ( )]

2n

F R l z in
c





            

                    
2

0 0 0

2
( , , ) (2 )exp[ ( )]

c

n

lz
V r z J rR i n rdrd dz

c

 
   



         (2.5.4) 

where ( ,Φ, )R l  are the cylindrical coordinates in reciprocal space, ( , , )r z are the 

cylindrical coordinates in real space, 
nJ  is the n-th order Bessel function, c is the 

periodicity in the tube axis, and 
2

2
( , , ) ( )

me
V r z v r

h


   is the modified scattering 

potential.  

When the atoms are located on a helix with a radius of or  and a pitch length C, the 

modified scattering potential has the following form 

2
( , , ))) ( (o o

z
V r z V r r

C


      .        (2.5.5) 

Using Eqn 2.5.5, the scattering amplitude can be expressed as 

                                
 

 
  ,      (2.5.6) 

For a SWNT, carbon atoms are only located on discrete points of the helix with radius 0r , 

shown in Fig. 2.4.1, the structure factor become 

0

2π
( ,Φ, ) exp[in(Φ )] (2 ) exp[ ( )]

2

j

n j j

n j

lz
F R l J r R f i n

c


      ,    (2.5.7) 
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where ( , )j jz  are the coordinates of carbon atoms, 
jf is the atomic scattering amplitude 

of carbon, summation   is done over atoms in an asymmetric cell and n over all integers 

which are allowed by selection rule (
Δ

l n m

c C
  ) discussed later.  

Since carbon atoms can be treated as discrete points with an equally spacing  on 

a continuous helix, as shown in Fig 2.5.1 [26]. The scattering potential of carbon atoms 

can be regarded as the product of a continuous helix and these equally spacing points.  

The diffraction pattern in reciprocal space is then convolution of the structure factor of 

the helix and that of the equally spacing points. This gives the allowed reflections on the 

diffraction layer line   through the following selection rule: 

Δ

l n m

c C
  ,           (2.5.8) 

where l is the coordinate for ( ,Φ, )F R l , c is the new structural periodicity in the axial 

direction of a single helix in a SWNT, and m is an integer. For a SWNT with chiral 

indices (u, v), we have perimeter 2 2 1/2( )oA a u v uv   , pitch length (60 )C Atan   ,  

helical angle 
3

arctan
2

v

v u


 
    

 and the distance between atoms sin(60 )oa    . 

The axial periodicity is given by 3 /hc C M where M is the maximum common divisor 

of (2u+v) and (u+2v). By using these relations, we can rewrite the Eqn. 2.5.8 as  

2 2( ) ( ) /l n u wv wm u v uv uM       .       (2.5.9) 
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Figure 2.5.1 Schematic of discrete points located on a continuous helix with a pitch 

length C.  is the spacing between two neighboring points group along tubule axis and c 

is the periodicity of the structure. Figure adapted from [26].      
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Meanwhile, the positions of carbon atoms in a SWNT can be expressed in 

cylindrical coordinates in the following equation 

 

 

1,0

0

1,0

0

(30 )
                    0,1,2,..., 1

(30 )

j

j

x ja cos
j v

z ja sin









   
 

 

                          (2.5.10) 

and 

   

   

1,1 1,0 0
0

1,1 1,0 0
0

(30 )
3

              0,1,2,..., 1

(30 )
3

j j

j j

a
x x ja cos

j v
a

z z ja sin









  

 

  








.               (2.5.11) 

Plugging Eqn. 2.5.10 and 2.5.11 into Eqn. 2.5.7, we can have the structure factor 

expressed as  

     
,

,Φ, , ( , ) exp Φ
2

uv uv uv n

n m

F R l f n m n m J dR in


  
  

   
  

 ,    (2.5.12) 

where 

 
 2

, 1 exp 2
3

uv

n u v m
n m i

v
 

   
    

   

 and  
 

 

1 exp 2
,

1 exp 2

uv

i n u v m
n m

u v m
i n

v






      
  

   
   

. 

From the above expression, the structure factor can be divided into two parts: (1) 

reflections of graphene lattice, which is described as   
,

, ( , )uv uv

n m

n m n m  ; (2) curvature 

effects from the cylindrical structure described as  
,

exp[ Φ ]
2

n

n m

J dR in



 

 
 

 . 

The intensity distribution of diffraction pattern is obtained by 

2| ( ,Φ, ) |uvI F R l .          (2.5.13) 
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The intensity distribution on each allowed diffraction layer is governed by Bessel 

functions with different orders. But only one specific Bessel function will be dominant in 

the intensity distribution while the contribution from other Bessel functions are 

insignificant [24]. This feature actually results in great convenience in the experiment for 

the determination of the chiral indices of a CNT. 

Fig. 2.5.2 is a simulated diffraction pattern of a SWNT [32]. The three primary 

layer lines 
1 2, l l  and 

3l , are the most significant diffraction layer lines. They are formed 

by the (10) , (10) and (11)  reflections of graphene. The two hexagons indicate the primary 

Bragg reflections from the top and the bottom surfaces of the carbon nanotube, giving six 

primary diffraction layer lines on the diffraction pattern. The elongation of the diffraction 

spots perpendicular to the tubule axis is due to a lack of translational periodicity in this 

direction. As we can see from the image, the peak of intensity is shifted because of the 

curvature of the carbon nanotube. 

The scattering intensity on the equatorial layer line (      is dominated by 

Bessel function of order 0 and the intensity is proportional to the square of the zero order 

Bessel function 0J . The three primary layer lines, 1 2, l l  and 3l have the values 

1 (2 ) /l u v M  , 2 ( 2 ) /l u v M  and 3 ( ) /l u v M  , respectively.  By using the 

selection rule, Eqn. 2.5.9, together with the value of 1 2, l l  and 3l , the order of dominant 

Bessel function of the three layer lines are solved out to be 1n v  , 2n u  and 

3 ( )n u v   , respectively. Therefore, the intensities of the 3 primary diffraction layer 

lines are 

2

1( , , ) | ( ) |vI R l J dR  ,         (2.5.14) 
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  2

2,Φ, | ( ) |uI R l J dR ,         (2.5.15) 

  2

3,Φ, | ( ) |u vI R l J dR .         (2.5.16) 

Eqn. 2.5.14, 2.5.15 and 2.5.16 provide a way to identify the chiral indices of a 

SWNT accurately and unambiguously by electron diffraction. Since intensities of the 

layer line 
1l   and 

2l  are dominated by the Bessel functions of order v and u, respectively, 

the order of the Bessel function can be derived from the ratio of the first two peak 

positions which can be measured directly on the diffraction layer lines.  Fig. 2.5.3(a) is 

the electron diffraction pattern of the SWNT (17, 2) together with the TEM image (inset) 

of the nanotube. The chiral indices (17,2) are derived from the ratio of first two peak 

positions, 1

2

X

X
 measured on the intensity profiles of the layer lines    and    as illustrated 

in the Fig. 2.5.3(b) and (c), respectively. 

The layer line spacings provide another way to identify the chiral indices of a 

CNT. As shown in Fig. 2.5.2, the line spacing    and    can be expressed 

*

1

*

2

(90 )
 

(30 )

D a sin

D a sin









  


 
                 (2.5.17) 

where 
*a  is basis vector of the graphene lattice in reciprocal space. Thus, the helical 

angle   can be rewritten as 

2 1

1

2
tan( )

3

D D

D



 ,         (2.5.18) 

Combining the Eqn. 1.2.5 and 2.5.18, the ratio of chiral indices are deduced into  

2 1

1 2

2

2

D Dv

u D D





 ,         (2.5.19) 
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Once the ratio of the chiral indices is obtained from the layer line spacings, the chiral 

indices can be usually determined unambiguously with supplementary information of 

tube diameter which can be directly measured from TEM images.  

Fig. 2.5.4 shows a diffraction pattern of a DWNT in which the red and the blue 

arrows are corresponding to the three primary diffraction layer lines from the inner and 

outer shells, respectively. The chiral indices are determined to be (43, 15) and (48, 21) 

according to the ratio of spacing of the layer lines 
1l   and 

2l . 
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Figure 2.5.2 Simulated electron diffraction pattern of a SWNT.   is the helical angle of 

the nanotube. 1 2, l l  and 3l are the primary diffraction layers resulting from the Bragg 

reflections of indices  ( 1 0 ), (10) and (11) directions. The two hexagons indicate the 

primary Bragg reflections from the top and the bottom portion of the carbon nanotube, 

giving six primary diffraction layer lines on the diffraction pattern. 1D , 2D and 3D  are 

the spacing between layer lines 
1 2, l l  and 

3l and the equatorial line. The elongation of the 

diffraction spots perpendicular to the tubule axis is due to a lack of translational 

periodicity in this direction. The peak is shifted because of the curvature of the carbon 

nanotube. Figure adapted from [32]. 
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Figure 2.5.3 (a) Electron diffraction pattern of SWNT (17, 2) taken in an experiment. The 

image is dyed for illustration purpose. Inset is the TEM image of the SWNT. (b) and (c) 

are the intensity profiles measured along the diffraction layer lines    and   . The blue 

curve and the red curve are the Bessel functions of order 2 and 17 used to fit the peak 

positions of the diffraction intensity, which is marked by     and     in the figures. 

Figure adapted from [32]. 

 



38 
 

 

 

 

 

 

 

Figure 2.5.4 Electron diffraction pattern of a DWNT of chiral indices (43, 15) and (48, 

21). The red and blue arrows point to the diffraction layer lines coming from (43, 15) and 

(48,  21), respectively. Inset is the TEM image of the DWNT.  
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Chapter 3  

Experimental Techniques  

 
 

 

3.1 Introduction 

All the experiments detailed in this thesis are done on a nano-electromechnical 

device built on a suspended CNT. The advantage of such a device is that it allows us to 

take the in situ CNT electron diffraction patterns while measuring its electrical and 

mechanical properties. The fabrication of the devices requires a lot of specialized nano-

device techniques. Some are routine fabrication techniques, such as photolithography and 

electron beam lithography. These methods will only be discussed briefly. However, the 

more original methods and skills are required for the success of fabricating high quality 

suspended CNT devices. They will be discussed in more detail in this chapter. A 

customized TEM specimen holder for these nano-electromechnical devices is also 

designed and constructed. It is capable of in situ electro-mechanical measurement via 

feed-through electrical probes. The details of the TEM holder will be described in the last 

section of this chapter. 
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3.2 Carbon Nanotube Deposition 

Since the discovery of CNT [1], there have been three major methods to grow 

SWNTs or MWNTs: (a) arc-discharge evaporation of graphite [1-5]; (b) laser ablation of 

graphite [6-9]; and (c) chemical vapor deposition [10-20]. They will only be discussed 

briefly here to explain the reason why chemical vapor deposition is chosen for my 

devices.  

In an arc-discharge synthesis, a DC or AC voltage is applied between two 

graphite electrodes which are separated by about 1 mm to create discharge plasma. The 

material on the anode is evaporated by high temperature plasma and is condensed on the 

cathode. Carbon nanotubes are found in the deposits on the cathode. When transition 

metals are present in the anode serving as catalysts, SWNTs can be synthesized on the 

cathode. Otherwise, only MWNTs are produced in the deposits [2].   

In the laser ablation method, a solid carbon target is placed in a quartz tube at 

high temperature. A pulsed laser is used to blast and to evaporate the carbon target. The 

products are found to be 90% pure CNT. If the target contains transition metal catalysts 

such as Rh/Pd and Ni/Co [6, 7], SWNT can be synthesized. Otherwise, products only 

contain MWNTs.  

The CNTs synthesized by both arc-discharge method and laser ablation method 

are in the form of black carbon soot. In order to make a single MWNT (number of shells 

larger than 2) device on a silicon based substrate, the products are usually suspended in 

dichloromethane because nanotubes tend to suspend freely in non-polar solvents. For 

MWNT deposition onto the substrate, a diluted drop of MWNT solution is mixed with 

several drops of isoproponal and is placed onto the substrate. The addition of isoproponal 
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can change the polarity of the MWNTs and makes the MWNTs easily to disperse on the 

substrate from the solution. The substrate is ready for further fabrication after it is dried 

under nitrogen flow. 

The dispersion of individual SWNTs or DWNTs on substrate is more challenging 

than MWNTs by the above method due to nanotube bundling, resulted from their low 

mass-to-surface area ratio. Surfactants or organic polymers are usually added into the 

nanotube solution to debundle carbon nanotubes by attaching positive or negative 

chemical molecules on the surface of nanotubes to overcome the attractive van der Waals 

force within the nanotube bundles [21, 22]. These suffactants can be removed later from 

nanotubes by changing solvent or by smooth oxidation. The result is good for dispersing 

CNTs on carbon grids for TEM imaging, but is far from being satisfied for dispersing 

individual CNTs uniformly on silicon substrate at a low concentration. The device 

fabrication requires a CNT density of about 5 nanotubes per one hundred square 

micrometers on the substrate. Thus, dispersion by liquid solution requires a CNT solution 

with a very low concentration. However, effects of surfactants in such a low 

concentration solution are not good and the individual CNT deposition is often not 

certain. Furthermore, the removal of surfactants by oxidation can very easily burn 

nanotubes or results in structural defects, especially when the number of nanotubes is 

small.  

Contrary to the arc-discharge or the laser ablation method, chemical vapor 

deposition can grow SWNTs or DWNTs directly onto a silicon substrate with a desired 

density which is controlled by the density of catalysts dispersed on the substrate. In this 

method, a silicon based substrate dispersed with metal catalysts is placed in a quartz tube 
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at high temperature. When passing through the quartz tube, organic gases are thermally 

decomposed and carbon nanotubes grow on the catalysts. It requires the catalyst particles, 

which usually contain Fe or Ni nano-particles, be of very small diameter (<10 nm). Since 

the nanotubes are grown on the catalysts, the density of CNT on the substrate can be 

precisely controlled by the catalyst density dispersed on the substrate.  

 

3.3 CNT Synthesis by Chemical Vapor Deposition 

The CNTs in our experiment are grown by chemical vapor deposition. Different 

catalysts, silicon based substrates and growth methods guided by Dr Jie Liu’s group in 

Duke University have been tried to achieve the required CNT deposition density on the 

device substrates [16-20, 23].  

Fe/Mo nano-particles are first used as the catalysts for SWNT synthesis in the 

CVD system. The catalysts are diluted into 1:100000 in hexane and then dispersed onto 

the silicon substrate. The substrates are annealed in air at 700 C for 10 minutes and then 

feeding gases consisting of methane, ethylene and hydrogen are purged through at  

900 C for CNT synthesis. The products are all SWNT nanotubes with diameter 

distributed between 2nm to 5nm.  Fig. 3.3.1 shows a typical SEM image of the SWNTs 

produced in this method. The distribution of SWNTs is not uniform on the substrate 

because the catalyst particles aggregate during the quick evaporation of hexane on the 

substrate surface. 
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Figure 3.3.1 SEM image of SWNTs using Fe/Mo nano-particles as catalysts. 

 

The quartz wafer (as the substrate) and iron chloride (as catalysts) are used to 

grow long and straight CNTs. The catalysts diluted in toluene are dispersed on the quartz 

wafer and then the wafer is transferred to the furnace at 900 C . The feeding gases 

consisting of methanol and ethanol are purged though the tube for CNT growth for 10 

minutes. The results turn out that the nanotubes are all SWNTs and are grown strictly 

along the (100) direction on the quartz wafer at the density of about 20 nanotubes per 

micrometer as illustrated in the Fig. 3.3.2. The SWNT can be transferred from the quartz 

wafer to the silicon substrate by sticking CNTs on a thick PMMA layer. The diameter is 

distributed from 1.5 nm to 3 nm sampled in TEM by transferring SWNTs to trenches on 

silicon nitride TEM grid as illustrated in Fig. 3.3.3. However, the density of CNTs is too 

high for fabricating individual CNT devices. 
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Figure 3.3.2 SEM images of SWNTs using quartz wafer as the substrate and iron chloride 

as catalysts. 

 

 

 

  

Figure 3.3.3 Low resolution (left) and high resolution (right) TEM images of a SWNT 

transferred from the SWNTs in Fig. 3.3.3. Scale bars, 100 nm (left) and 5 nm (right). 
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In order to grow long nanotubes and reach the required SWNT/DWNT density on 

the silicon substrate, the following method is finally chosen in our experiments (the 

details of the growth method are discussed in Appendix I) [18]. For a DWNT growth, 

2FeSi is used as the metal catalyst. The 2FeSi
 
is first crushed into small particles and 

then is soaked in ethanol. The catalysts are deposited onto the substrate by evaporation of 

the catalyst suspension. The substrate is heated in a 2.5 cm quartz tube in air at 
o900 C  

for 20 minutes and followed by a 10 minutes purge of Ar to remove the air. The 

temperature is raised to 
o925 C  and carbon feeding gases, which consist of methane 

(1500 sccm), ethylene (30 sccm), and hydrogen (500 sccm), are introduced into the tube 

for nanotube growth. After 10 minutes of growth, argon, methane and ethylene gases are 

turned off. The system is cooled to room temperature in the purge process with hydrogen 

gas. The products show a DWNT percentage of more than 90% without any purification 

and a DWNT diameter of 4.5 0.5 nm , as illustrated in Fig. 3.3.5 [18]. Fig. 3.3.6 is a 

TEM image of a DWNT grown across the trench on a silicon nitride membrane. In 

SWNT growth, most procedures are the same as that of DWNT, but iron nitrate is usually 

used as metal catalyst and no anneal procedure is needed.  
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Figure 3.2.5 Diameter distribution of DWNT grown by chemical vapor deposition 

directly onto a substrate. The image is adapted from [18]. 

 

 

 

 

 

 

 

 

 

 

Figure 3.2.6 High resolution TEM image of a DWNT grown across a trench on a silicon 

nitride membrane by the chemical vapor deposition method. The scale bar is 5 nm.   
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3.4 Nano-Electromechanical Device Based on a Suspended CNT 

Two types of CNT devices are used in this thesis to study the correlations 

between the nanotube properties and its chiral structure. In the first type of device, a 

single carbon nanotube is suspended in air between two or four anchoring electrodes 

which are used to measure the electrical resistance of the CNT. In the second type of 

device, a single carbon nanotube, which is suspended between two anchoring electrodes, 

works as a torional bearing attached with a metal anchor. An external electric field is 

applied via a side gate to actuate the metal paddle and thus to twist the nanotube, as 

illustrated in Fig. 3.3.1. The torsional strains and the corresponding electromechanical 

response of the CNT can be measured simultaneously on this type of device. The details 

of device fabrication will be described in Appendix II. Due to the similarities between 

two types of devices, this section focuses on a brief description of the fabrication of the 

second type device.   

(1) Positive photolithography is performed on the back side of the wafer, Fig. 

3.3.2(A). A commercial photoresist (Shipley S1813) is spin-coated (3000 rpm for 60s) on 

the wafer backside. After soft baking the sample on a hot plate at 115℃ for 1 minute, the 

sample is cooled down and transferred to a mask aligner (Karl Suss MA6/BA6). 

Ultraviolet light (wavelength 365 nm) is used to expose the photoresist through a 

photomask which is patterned with a matrix of 1 mm×1 mm squares separated by 10 mm. 

Then, the sample is dipped into a developer solution (Rohm and Haas MF 319) to remove 

the de-crosslinked regions. 
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Figure 3.3.1 Schematic of CNT torsional device. A metal paddle is suspended on an 

individual CNT which is held by two metal anchors across an opening etched on a 

membrane consisting of 300 nm silicon dioxide and 300 nm silicon nitride. A side gate is 

placed aside to actuate the metal paddle by an applied voltage. 

 

(2) The silicon nitride layer on top of which the photoresist has been removed is 

etched away in a reactive ion etching (RIE) process, as illustrated in Fig. 3.3.2(B). The 

sample is placed in the RIE chamber at an atmosphere of 3 8C F and 2O  gases. Chemically 

reactive plasma are induced in the chamber by an electromagnetic field to etch the 

exposed silicon nitride layer. The rest of the wafer is protected from etching by 

photoresist. The photoresist is removed by sonication in acetone for 30 seconds after 

etching. 

(3) The sample is placed in 15% potassium hydroxide solution at 70 C for silicon 

etching, as illustrated in Fig. 3.3.2(C). Potassium hydroxide is an anisotropic silicon 



52 
 

etchant and etches the silicon (100) with an angle of 54.74
°
 from the plane at a speed 

about 1 μm per minute. The silicon nitride layers coated on both sides of the wafer work 

as a KOH stopper to protect the silicon beneath from etching. Only the areas on top of 

which the nitride layer is etched away by RIE in the last step are exposed to KOH. The 

etching process is stopped when the etching depth reaches 400 μm, leaving a 100 μm 

silicon layer which works as a support to protect the underlying nitride layer from 

breaking in future sonication.  The entire process is supervised in an optical microscope 

in case the sample is over-etched.  

(4) A 50 nm silicon nitride layer and a 300 nm silicon dioxide layer are deposited 

onto the top surface of the sample by plasma enhance chemical vapor deposition 

(PECVD), Fig. 3.3.2(D). Although silicon nitride is a good etchant stopper in KOH 

solution, the defects on the nitride layer will be enlarged and thus the local nitride will be 

etched through by KOH in a long time etching process (usually about several hours). This 

effect results in pin holes (on the micrometer order) on the surface. As the result, circuit 

fabricated on the surface will be short to the substrate if metal happens to be deposited on 

these pin holes. Therefore, a 50 nm PECVD silicon nitride layer is first coated on the 

wafer surface to block these pin holes. Another 300 nm silicon dioxide layer is deposited 

onto the substrate for CNT growth.  

(5) CNTs are grown onto the sample surface by chemical vapor deposition as 

mentioned in the last section. The samples are checked by SEM to ensure that there are 

enough CNTs on the wafer for the next step fabrication. 
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Figure 3.3.2 Schematic of the first 4 steps of device fabrication. (A) Photolithography is 

performed on the backside of the wafer. The photoresist protects the covered area from 

RIE etching. (B) RIE etching is applied to etch the silicon nitride without the protection 

of photoresisit. (C)  The sample is dipped in 15% KOH solution for silicon etching. 

Etching is stopped when the etching depth reaches 400 μm. 100 μm silion layer is left as 

a support for the silicon nitride layer. (D) A 40 nm silicon nitride film and 300 nm 

dioxide film is deposited onto the top surface of the wafer by PECVD.  

  

(6) Another positive photolithography is performed on the top surface of the 

samples. The procedure is the same as those discussed in the first step. The only 

difference is that a different photo mask patterned with electric circuits is used here. The 

samples are carefully aligned to the mask so that the micro-electrodes will be patterned 

onto the places which are right on the top of those trenches etched on the backside in the 

last step. Following directional evaporation of metal (10 nm Cr and 60 nm Au) onto the 

patterned wafer, all the photoresist is removed with an acetone soak. Metal deposited 

atop the resist is removed along with the resist by acetone soak, leaving metal where 

exposure occurred. The surface is patterned with eight individually addressable 
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macroscopic electrodes that decrease in size to an 80 μm × 80 μm area where devices are 

to be fabricated, marked by the circle as illustrated in Fig. 3.3.3 [24].  

 

 

Figure 3.3.3 Schematic of the macroscopic electrodes deposited onto a wafer by 

photolithography. The schematic is not drawn to scale for illustration purpose. Adapted 

from [24]. 

 

(7) CNTs are broken apart by applying a large current (tens of micro amperes) 

between the neighboring electrodes if the CNTs are bridging multiple leads as illustrated 

in Fig. 3.3.4(A) and (B). The large amount of heat generated as a large current (about 

10 40 μA ) passing through CNTs causes the oxidation of carbon atoms and thus breaks 

the nanotubes. As the result, the applied current will become immeasurable once the 

nanotube is broken. 

(8) Two steps of electron beam lithography are performed on the sample: the 1st 

lithography for small fiduciary marks used as the precise location marks of CNTs for the 

metal patterns in the 2nd lithography; the 2nd lithography for patterning metal anchors 

and paddles onto the nanotubes as illustrated in Fig. 3.3.4(B) and (D). The procedure of 
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electron beam lithography is very similar to that of photolithography, except that the 

photoresist is replaced by electron beam resist poly methyl methacrylate (PMMA) here. 

A low molecular weight (M=350 K) PMMA is spin-coated on the sample at the spin 

speed of 5000 rpm, and then subject to a soft bake (180 ℃) for 2 minutes on a hot plate. 

A second layer PMMA (M=996K) is spin-coated on the sample at the spin speed of 4000 

rpm, and then subject to a 2 hours bake (180 ) in a furnace to remove the solvent. After 

exposed to electron beam, the sample is soaked in developer (mixture of methyl isobutyl 

ketone and isoproponal at the ratio of 1: 3) to remove the exposed PMMA. Thermal 

evaporation is followed to deposit 10 nm Cr and 80 nm Au onto the sample surface. The 

metal atop the undeveloped PMMA is removed by acetone soak, leaving the substrate-

bound areas only where exposure occurred. Double PMMA layers are used to help metal 

peel off in acetone soak. Since the lighter PMMA is more sensitive to electron beam than 

the heavier PMMA, it will be de-crosslinked more under the same electron dose and give 

an undercutting gutter after lithography, as illustrated in Fig. 3.3.5. Such a shape makes 

the metal atop the PMMA more easily to peel off when the underlying PMMA is 

dissolved in acetone.  

(9) A wet etching process is used to remove the 100 μm silicon layer underlying 

the devices, as shown in Fig. 3.3.6 (A) and (B). The sample is placed up-side down on a 

hot plate at 60  and HNA (the solution mixed by hydrofluoric acid, nitric acid and 

acetic acid) is dripped into the trenches which are etched in the third step to remove the 

remaining 100 μm silicon layer, leaving a 300 nm nitride and 300 nm silicon dioxide 

membranes to support the devices. HNA can etch the silicon at a speed about 2 μm per 

minute at 60 .  
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Figure 3.3.4 (A) SEM image of the device area before electron beam lithography. The 

CNTs marked by black circle bridge the neighboring electrodes and are broken by 

applying a large electric current. (B) The nanotubes are broken after a large current 

oxidizes the carbon atoms. The inset is an enlarged SEM image where the CNT is broken 

point. (C) SEM image of the device after metal paddles and anchors are patterned. (D) 

An enlarged SEM device image of the area marked by the rectangle in (C).  

 

 

 

Figure 3.3.5 Schematic of bilayer PMMA for electron beam lithography, resulting in a 

desirable T-structure (right) and low remnant material on the surface. Adapted from [18]. 
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(10) Focused ion beam (FIB) is used to etch away the silicon nitride layer right 

below the CNT device as illustrated in Fig. 3.3.6(C). A cross fiduciary mark used as 

alignment mark is first etched through on the front side of the device. Then, the device is 

flipped 180  and the positions of CNT devices on the membrane are located according to 

the fiduciary mark. Windows with a size of 1.2 μm×1.8 μm are etched on these positions, 

leaving a 300 nm silicon dioxide layer to support the devices.   

(11) Buffered hydrofluoric acid (BHF) is used to etch the 300 nm silicon dioxide 

layer which is left in the last step to fully suspend the nanotube and the paddle on the tube 

as illustrated in Fig. 3.3.6(C). PMMA (M=996 K) is first spin-coated onto the sample 

surface, working as a BHF stopper. Another electron beam lithography is then performed 

on the sample to open a 0.4 μm×0.8 μm etching window on the device, leaving the rest of 

sample protected by PMMA from BHF. A drop of BHF is placed onto the device for 5 

minutes to etch away the silicon dioxide layer.  

(12) In the final step, the sample is dried by (super)critical point drying, which 

prevents the suspended nanotube devices from being exposed to surface tension during 

evaporative drying, which generally causes devices to fail. The sample is first submerged 

in acetone to remove the PMMA. Then the sample is transferred to ethanol and 

immediately dried using supercritical carbon dioxide. The final device is then complete 

and ready for experimentation as illustrated in Fig. 3.3.6(D) and Fig. 3.3.7.  
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Figure 3.3.6 Schematic of device fabrication step 8 to 12. (A) Electrodes and paddles are 

patterned onto CNTs by electron beam lithography followed by metallization. (B) HNA 

is dripped into the tenches etched on the backside of the wafer to remove the 100 μm 

silicon layer. (C) FIB is performed to remove the silicon nitride layer right underlying the 

metal paddle and BHF is used to remove the silicon dioxide layer underlying the paddle, 

leaving the paddle suspended in air. (D) The schematic of a final device. 
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Figure 3.3.7 TEM image of a finished device with one fully suspended CNT and a pedal 

on it. 

 

 

3.5 Design and Construction of a Customized Transmission Electron Microscope 

Specimen Holder 

In order to input electric signals into the device in TEM, the TEM specimen 

holder has to have feedthrough electric probes. The most common specimen holders are 

the single tilt and double tilt holders, in which samples can be rotated by a single axis and 
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two axes, respectively. A customized holder was designed and constructed in this study 

in order to adapt the size of my devices shown in Fig. 3.3.3.     

The specimen holder consists of 4 major parts: (i) shaft, (ii) device stage, (iii) 

head feedthrough and (iv) tail feedthrough, as illustrated in Fig. 3.4.1. The shaft is very 

similar to the normal single tilt TEM holder and most dimensions are measured from the 

JEOL JEM 2010F single tilt sample holder. It is made from aluminum for convenience 

and weight consideration. The two grooves on the shaft marked in Fig. 3.4.1 are 

fabricated for o-rings, which are used to seal the vacuum. The two ends of the holder 

shaft are designed to fit the head feedthrough and the tail feedthrough.  

The tail feedthrough feeds 8 electric wires into the specimen holder from 

atmosphere. The commercial 8 Pins- Del Seal CF electrical feedthrough purchased from 

MDC Vacuum Products Corporation is used here as shown in Fig. 3.4.2. It is attached to 

the end of the holder shaft by vacuum glue. It can be removed from the holder shaft by 

heating the holder at 200  for 1 hour if needed.  

The head feedthrough is used to connect the 8 electric wires sealed inside the 

holder shaft to the 8 electrical probes on the sample stage as illustrated in Fig. 3.4.3. It is 

inserted into the head of the holder shaft and fixed by two screws (size 0-80). Eight holes 

are drilled through the feedthrough and 8 metal pins are inserted, serving as electrical 

connectors between the wires inside the holder and the probes on the sample stage. The 

whole feedthrough coated with alumina by anode oxidation and it is electrically 

insulating to the eight pin leads. Vacuum glue is applied on the sealing grooves on both 

ends to seal the apertures between the pins and the holes.  
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The 8 electrical probes attached to the grooves on the sample stage (illustrated in 

Fig. 3.4.4) by vacuum glue are made by phosphor bronze because the material is elastic 

and has a low Hooke constant. When the sample is pushed onto the 8 pins, the end of the 

probes will be bent down like a spring and secure good contacts between the pins and the 

electrodes. The other ends of the probes are connected to the head feedthrough by 

electrical wires.  
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Figure 3.4.1 Schematic of the home built TEM holder. It consists of 4 parts: device stage, 

head feedthrough, tail feedthrough and shaft. 

 

 



63 
 

 

 

 

 

Figure 3.4.2 Picture of the commercial feedthrough purchased from MDC Vacuum 

Products Corporation. It is attached to the end of the TEM holder shaft, connecting the 8 

electrical wires inside the holder to the power supply outside the TEM.  

 

 

 

 

Figure 3.4.3 Schematic of head feedthrough. The two grooves are for o-rings to seal the 

air inside the holder shaft. The length of an electrical pin is about 2 cm. 
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Figure 3.4.4 (A) Schematic of the sample stage. (B) Optical image of the TEM sample 

stage. 
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Chapter 4 

  

Electrical Resistance of Singe-Wall and Double-

Wall Carbon Nanotubes with Determined Chiral 

Indices 

 

 

 

4.1 Introduction 

Nanotubes can be metallic and their carrier mobilities are much higher than 

metals, suggesting that they could be ideal interconnects in nanoelectronic devices. They 

can also be semiconducting, as controlled by their chiralities, and the intrinsic 

semiconducting characteristics allow us to build logic devices on the nanometer scale. 

Furthermore, their mechanical stability and robustness make it possible to fabricate long-

lasting devices. Therefore, tremendous theoretical and experimental research on the 

electrical properties of carbon nanotube has been done to explore this novel one-

dimensional material since its discovery 20 years ago [1-10].   

A number of molecular simulations and theoretical calculations have been applied 

to study the band gaps of semiconducting CNTs. In 1995, a precise expression between 

nanotube’s chirality and its energy gap was given by Yorikawa and Muramatsu [11]. This 

expression includes the effect of mixing between the   and the  orbitals due to the 
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curvature of CNT and thus gives a precise description of the band gap based on the tight-

binding approximation. Starting from graphene, the band gap consists of two parts in 

their model: one is independent of the nanotube helical angle donated by
0E ; another is 

dependent on helical angle   donated by E . The energy gap can be written as [11] 

0gE E E  .          (4.1.1) 

If the curvature is neglected, the energy gap given by Eqn. 4.1.1 will reduce to that of a 

two-dimensional graphene sheet. In the  -electron model,  

0 /pp dE V R ,          (4.1.2) 

where 
ppV  is the tight-binding parameter for   orbital, 

dR is the tube radius divided by 

the carbon-carbon atom distance 0 0.142 nmd   and E  has the form  

 1

2

( 1) ( ) /
p n n

n d

n

E f R 




   ,         (4.1.3) 

whose the leading term is
2( 1) | | cos(3 ) /p

pp dV R   , and where  is a constant factor 

having value of 1/12 and p is the reminder of / 3u v . But when the curvature of tube 

causes a mixing of the   and  orbitals, 
ppV  in 0E  and E  should be modified with a 

coefficient related to nanotube’s radius and  should take a value different from 1/12.  

In their calculation, Yorikawa and Muramatsu constructed an 8 8  Hamiltonian 

matrix ( )H k with a wave vector k and included the 2s and 2p orbitals to take into the 

account of mixing of the   and  orbitals. The matrix elements are given as a function of 

dR  and the helical angle and contain 5 tight-binding parameters, , , pp ppV V 

,  and =( ).sp ss s pV V       Each primitive cell of the carbon nanotube has two 

independent atoms, A and B, and ( )H k has the following form: 
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   
i j i jA A B B i jH k H k    ,        (4.1.4) 

   
1,2,3

exp[ ]
i j

l

A B ij l A

l

H k h ik r r


   ,        (4.1.5) 

and 

 
'

'

' 1,2,3

exp[ ]
i j

l

B A ij Bl
l

H h ik r r


   ,        (4.1.6) 

where i or j is a suffix for the basic states of   and   orbitals, 
Ar  and 

Br  are the positional 

vectors for atoms A and B, 
lr and 'l

r  are the positional vectors for the nearest neighbors, 

and 
l

ijh and 
'l

ijh contain the five tight-binding parameters , , , pp pp sp ssV V V V    and 

=( )s p    . After solving the matrix, the expression of band gap is given as 

 | | cos 3
( ) [1 ( 1) ]

pp p

g d

d d

V
E R

R R

 
     ,      (4.1.7) 

where | | 2.24 eV,ppV   0.4   and 21 0.4 / dR    for Tomanek and Schluter parameters 

and | | 2.77 eV,ppV    0.25   and 21 0.3 / dR    for Mintmire, Robertson and White 

parameters [12, 13]. 

Experimental measurements on the atomic structure and electronic properties of 

single-wall carbon nanotubes followed quickly by Odom et al. at Harvard University [14] 

and Wildoer et al. at Delft University of Technology [15] in 1998. STM was used to 

characterize the atomic structure of a single carbon nanotube which was deposited on a 

Au (1,1,1) surface. The chiral indices were determined from the tube diameter and the 

angle between the tube axis T and the direction of nearest-neighbor hexagon rows H, as 

shown in Fig. 4.1.1. Meanwhile, I-V curves of the nanotube were measured via a bias 

voltage between the STM tip and the Au substrate. Fig. 4.1.2b gives the calculated 
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normalized conductance and the measured I-V curves from the positions on the nanotube 

indicated by the symbols in Fig. 4.1.2a, from which the nanotube’s chiral indices were 

determined to be (14, 3) (helical angle 11.2°±0.5° and diameter 0.95±0.05 nm). The 

calculated ( / ) /V I dI dV showed two sharp increases at -325 and 425 mV that correspond 

to the valence and conduction band edges in the local density of states. Thus, the energy 

gap can be assigned to be 750 mV. Their results show that the energy gap has a 1/r 

dependence, and can be fitted to /g pp c cE V a r  , where 2.45 eVppV    is the carbon-

carbon tight-binding overlap energy, 
c ca 

 is the carbon-carbon bond distance and r is the 

tube radius. 

In an STM experiment, the I-V curves were measured between the STM tip and 

the underlying gold substrate instead of the two ends of a nanotube. Two terminal 

electrical transport measurements on a single nanotube with ohmic contact to the metal 

probes were reported by Dai’s research group in 1999 [16, 17]. In their experiment, metal 

probes (15 nm Ti followed by 70 nm Au) were patterned onto the two ends of an 

individual single-wall carbon nanotube which was deposited on the SiO2 surface by 

chemical vapor deposition. Electrical transport properties of the nanotube were 

characterized by the I-V curves measured on the metal probes at room temperature and 4 

K, respectively. Fig. 4.1.3 shows the I-V curves of a semiconducting SWNT measured at 

different gate voltages (  ) at room temperature. The linear relation at 0gV 
 
indicates 

that the semiconducting SWNT has a constant electrical resistance at low bias voltage at 

room temperature. The inset is the I-V curve of the SWNT at 4 K without gate voltage. 

The sharp increase at both sides of voltage indicates that the nanotube has a band gap of 

0.8 eV. On the contrary, the I-V curve shown in Fig. 4.1.4 is linear and indicates the 
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nanotube is a metallic SWNT. The inset is the electrical resistance as a function of 

source-drain voltage derived from the I-V curve.  

 

 

Figure 4.1.1 Atomically resolved STM image of individual single-walled carbon 

nanotube on the Au (1,1,1) surface. The dashed arrow indicates the tubes axis T and the 

solid arrow indicates the direction of the nearest-neighbor hexagon rows H. The angle 

between T and H is the helical angle of 7° (chiral indices (11, 7) and diameter 1.2 nm). 

Image adapted from [15]. 

 

 

Later on, many modifications [18-21], such as side gates and contacting metals, 

were made on this circuit design to improve the measurement and a much better picture 

of nanotubes’ electrical properties has been obtained. However, the determination of the 

nanotube’s chiral structure is impossible in this kind of experiment. It would be desirable 

from both a scientific and technological point of view to measure the electrical transport 

properties and the chiral indices simultaneously. STM, as we mention above, has the 

capability to measure the chiral structure and band gap of a nanotube, but its application 

is only limited to the SWNTs of small diameter because of the morphological 

deformation caused between the substrate and SWNTs [22, 23]. Furthermore, the I-V 

curves in STM experiment were measured between STM tip and the underlying gold 

substrate and thus, did not directly represent the electrical transport properties along the 

tubule axis.  
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One way to achieve this goal is to make CNT based two-terminal electrical 

circuits applicable to in situ TEM imaging and electron diffraction. This requires that the 

nanotube between the two metal probes be suspended and the substrate beneath the 

nanotube be etched completely away. Another important advantage of such device 

geometry is that it is not only applicable to SWNTs but also to MWNTs. This chapter 

details this new method and the results obtained. 

 

 

 

Figure 4.1.2 (a) STM image of an individual single-walled carbon nanotube deposited on 

the Au (1,1,1) surface. The chiral indices are determined to be (14, 3) (helical angle 

11.2°±0.5° and diameter 0.95±0.05 nm). (B) Calculated normalized conductance and 

measured I-V (inset) data from the positions indicated by the symbols in (A). Images 

adapted from [14]. 
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Figure 4.1.3 I-V curves of a semiconducting SWNT measured at different gate voltages 

at room temperature. Inset is the I-V curve of the same nanotube measured at 4 K with no 

gate voltage.  Image adapted from [16]. 

 

 

 

 

Figure 4.1.4 I-V curve measured on a metallic SWNT at 4.2 K. Inset is the electrical 

resistance as a function of the source-drain voltage. Image adapted from [16]. 
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4.2 Experimental Method 

Electrical leads were deposited onto the nanotube by electron beam lithography in 

order to measure the I-V curves of the nanotube at room temperature as shown in Fig. 

4.2.1(A) (the device fabrication is discussed in Chapter 3). Two types of metals, Au/Cr 

and Pd, were utilized as the metal electrodes here. Four-probe electrodes consisting of 60 

nm Au and 5 nm Cr were patterned on the SWNTs to minimize the effect of Schottky 

barriers between the nanotubes and metal probes in the I-V measurements. Since Pd has a 

very good ohmic contact to nanotubes (four probe measurements show that the contact 

resistances are about a few kΩ, much smaller than those of nanotubes at room 

temperature) [21], two-probe electrodes of 70 nm Pd were deposited onto the DWNTs. 

All the electrode leads were earthed first to remove the possible static electric charges 

before an I-V measurement. After the I-V curves were measured on nanotubes, HNA (a 

solution mixed with hydrofluoric acid, nitric acid and acetic acid) and focused ion beam 

(FIB) system were used to etch away the silicon layer and the silicon nitride layer 

beneath the CNT. The silicon dioxide layer was removed by hydrofluoric acid, leaving a 

free standing CNT anchored by the metal leads as shown in Fig. 4.2.1(B). The CNT 

device was then transferred to the TEM (JEOL JEM 2010F operated at 80 kV) for 

imaging and nano-beam electron diffraction as shown in Fig. 4.2.1(B)-(C). Finally, the 

chiral indices of the CNT were determined from the electron diffraction patterns and the 

diameter which was directly measured in the TEM images [24]. 
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Figure 4.2.1 (A) Schematic of a 4-probe CNT device ready for TEM imaging and 

electron diffraction. (B) TEM image of the first SWNT listed in Table 4.1. The SWNT 

was suspended in air and anchored by metal leads (dark area) on the two sides. Inset: A 

high magnification TEM image of the same SWNT. The scale bar of inset is 10 nm. (C) 

An electron diffraction pattern of the same SWNT from which the chiral indices (27, 6) 

were derived. L1, L2 and L3 are the principal layer lines. The left half of the image is the 

original electron diffraction pattern of the SWNT. The signal-to-noise ratio of the right 

half was enhanced by adjusting the contrast and brightness. (D) I-V curve of the SWNT 

measured at room temperature. The non-linearity of the I-V curve and the high resistance 

indicate large Schottky barriers between the SWNT and the metal leads in the device. 
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4.3 Results and Discussion  

Eight individual SWNTs, four semiconducting SWNTs and four metallic SWNTs, 

and two DWNTs have been measured in our experiment. The chiral indices (u, v), 

metallicity, electrical resistance, nanotube length, nanotube diameter, and calculated 

electronic band gap Eg [4], electrical resistivity are listed in Table 4.1. 

The chiral indices of the first nanotube, (27, 6), determined by the ratio of the 

principal diffraction line spacings in combination with a measurement of the nanotube 

diameter from the TEM image [24], satisfy the condition p=0, , where p is the reminder 

of |u – v|/3  [2]. It is therefore a metallic CNT. However, its I-V curve measured at room 

temperature (300 K) has an obvious non-linearity and a resistance of about 3 MΩ. This 

resistance is much larger than the quantum-limit resistance expected for the ballistic 

SWNT ( 0 2
6.5 k

4

h
R

e
   , quantum-limit conductance 0 01/G R ) [25, 26] and it 

actually resulted from the Schottky barriers in the poor contacts between the metal leads 

and the SWNT [27]. An annealing process was used in our experiment to improve the 

contact between the gold metal lead and the SWNT [28]. A four-probe method was used 

to minimize the effects from the contact resistances. In the measurement of the latter 

seven SWNTs, the contact resistances are in the range of 3-5 kΩ (~5% of the SWNT 

resistance) measured by the four-probe method.  
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Table 4.1 Chiral indices (u,v), metallicity, electrical resistance, nanotube diameter, 

nanotube length, resistivity of the 8 SWNTs and 2 DWNTs measured in our experiment. 

Column 8 lists the electronic band gaps of the nanotubes calculated by the method 

reported by Yorikawa and Muramatsu [11] using Tomanek and Schluters’ parameters 

[12]. The last column is the resistivity estimated by Eqn. 4.3.2. 
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Figure 4.3.2. (A) I-V curves for the four semiconducting SWNTs (no. 5, 6, 7 and 8) 

measured by 4-probe method at room temperature. (B) I-V curves for the metallic 

SWNTs (no. 2, 3 and 4) measured by 4-probe method at room temperature.  
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The second, third and fourth metallic SWNT listed in Table 4.1 have  resistances 

of 56 kΩ, 25 kΩ and 30 kΩ at room temperature (300 K), as measured from their I-V 

curves shown in Fig. 4.2.2(A).  For a metallic SWNT, acoustic phonon scattering is the 

main factor which determines the resistance at low bias [29, 30]. The resistance in a 

metallic SWNT due to this factor can be expressed as 

  24 ( )
ap

ap

h L
R T

e L T
 ,                                                         (4.3.1) 

where h is the Planck’s constant, e is the electric charge of electron, L is the length of the 

SWNT between two metal leads and     is the mean free path (mfp) for acoustic phonon 

scattering, which is a function of temperature of T and increases with increasing 

temperature [21]. From the measured electrical resistance, it provides a rough estimation 

of     to be about 120 nm, 148 nm and 130 nm for these three metallic SWNTs at 300 K. 

An SEM image of the 4-probe metal leads on the 7th SWNT in Table 4.1 is 

shown in Fig. 4.3.3(A). The chiral indices determined from the electron diffraction 

pattern in Fig. 4.3.3(B) are (38, 21) which satisfy the semiconducting SWNT condition 

that 3 2u v g    [2], where g is an integer. Similar to the metallic SWNT, the four 

semiconducting SWNTs in Table 4.1 exhibit a linear I-V relationship as shown in Fig. 

4.3.2(A) and the resistances are about 100 kΩ. The amorphous material around the 

SWNT shown in Fig. 4.3.3(C) is amorphous carbon deposited onto the nanotube during 

long exposure.  

As expected, the resistivity of SWNT increases with the band gap for a 

semiconducting SWNT. We can make an estimate of the electrical resistivity at room 

temperature based on the band gap of a nanotube. The static electric charges on the 
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nanotube are removed via grounding of all the electrodes before I-V measurement. The 

low bias voltage (about 10 mV) which is much smaller than the energy gap of a nanotube 

(around 100 mV) is insufficient to induce the tunneling between the conduction band and 

the covalence band. Therefore, the electronic transport carriers of a semiconducting 

SWNT at room temperature mainly come from the electrons which are thermally excited 

from the valance band into the conduction band. At a fixed temperature, the density of 

charge carriers is a constant in a semiconducting SWNT. Therefore, it gives a linear 

relationship in the I-V curves.  

 

 

Figure 4.3.3 (A) SEM image of the 4 metal (Au/Cr) leads on the 7th SWNT given in 

Table 4.1 produced by electron beam-lithography. The I-V curve of the SWNT is 

measured by these 4 probes. (B) Electron diffraction pattern of the same SWNT. L1, L2, 

L3, L4, and L5 are the principal layer lines from this SWNT. The chiral indices were 

determined to be (38, 21) from the diffraction pattern. The image is inverted to negative 

contrast for clarity. (C) TEM image of the SWNT. Scale bar, 50 nm. 

 

The possibility for an electron being excited to the conduction band is 

proportional to exp( )
B

gE

k T
 , where Eg is the band gap and kB is the Boltzmann constant. 
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The carrier (electrons) density is proportional to exp( )
2

g

B

E

k T
 . The conductance is 

proportional to the same factor. The lengths of the four semiconducting SWNTs are 

around 0.5-1 μm which are smaller than 
54 10 /apL D T   [31], where D is the nanotube 

diameter in nm and T is the absolute temperature. Hence phonon scattering may have 

only a small effect on the resistances. The resistivity of a semiconducting SWNT at room 

temperature can then be estimated by  

2
exp( )

4 2

g

B

Eh
R

e k T
 .                                 (4.3.2) 

The estimation of the resistivity is listed in the last column of Table 4.1. The 8th SWNT 

(33, 16) is 254 kΩ, in excellent agreement with the experimentally measured resistance 

normalized by its length (251 kΩ) as shown in Table 4.1. The numerical estimation of the 

resistivities on the rest semiconducting SWNTs is also very close to (about 10%-13% off) 

the measured resistivities.  

Other factors may also contribute to the electrical resistance of a carbon nanotube 

such as morphological deformation. SWNTs show a dramatic band gap dependence on 

their deformation such as uniaxial and/or torsional deformation [2, 22, 32-34]. In our 

experiment, the SWNTs might be under stress at the interface between the substrate 

surface and the nanotube and therefore have some deformation. The decrease on the band 

gap caused by the deformation would decrease the electrical resistance. 

Two DWNTs were measured in devices 9 and 10 as listed in Table 4.1. From the 

diffraction pattern and direct TEM imaging, Fig. 4.3.4(A)-(B), we derived that the 

DWNT in device 9 has the chiral indices of (40, 12) and (28, 15) which has a 

semiconducting-semiconducting shell combination.  DWNT in device 10 has the chiral 
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indices of (54, 11) and (47, 8) which has a semiconducting-metallic shell combination. 

The room temperature resistivities of the two DWNTs derived from the I-V curves, Fig. 

4.3.5, are very close to (about 10% off) the estimated resistivities (see Table 4.1) 

calculated from the band gaps of outer-shells, but are far away from the estimated 

resistivities of inner-shells. For the DWNT device 9, the estimated resistivity of the inner 

shell is about 200% larger than the experimental values. If the shells were parallel in the 

electrical transport, the total resistance would be 120 kΩ and about 30% smaller than the 

experimental value. For the DWNT device 10, the total resistance of the parallel transport 

is 31 kΩ if the average resistivity of the metallic SWNT device 2, 3 and 4 is used as that 

of the inner shell. It is about 70% smaller than the experimental value.  Therefore, I 

conclude that electrons only transport along the outer-shell of a DWNT in a metal-on-top 

mode circuits, even though the nanotubes are buried beneath the metal electrodes. One 

very possible reason is that the metal probes only has good contact to the outer-shell and 

the coupling between the two shells is very weak due to the weak van der Waals 

interaction [35, 36].  
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Figure 4.3.4 (A) TEM image of the DWNT in device 9 listed in Table 4.1. The DWNT 

was suspended in air and anchored by metal leads (dark area) on the two sides. The 

amorphous material around the nanotube is carbon deposited onto the nanotube during 

long exposure. The scale bar is 50 nm. (B) An electron diffraction pattern of the same 

DWNT from which the chiral indices (40, 12) and (28, 15) were derived. Principal layer 

lines L1 and L2 marked by red and black arrows are coming from the outer-shell and 

inner-shell, respectively.  
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Figure 4.3.5 I-V curve for the DWNTs in device 9 and 10 measured by 2-probe method at 

room temperature.  
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Chapter 5  

 

Direct Measurement of the Friction between 

Walls of Carbon Nanotubes and Shear Modulus 

 

 

 

5.1 Introduction 

Besides the rich variety of intriguing electronic properties, carbon nanotubes also 

exhibit amazing mechanical properties which make them a very attractive candidate for 

use in nano-electromechanical system (NEMS) devices [1-5]. As discussed in the Chapter 

1, mechanical modulus, which is larger than that of diamond, makes CNTs the strongest 

and most robust material known to man [3, 6]. Furthermore, SWNTs and MWNTs can 

bear large torsional strains along their tubule direction without plastic deformation or 

buckling [7-9].  Based on these properties, nano-scale devices which employ a CNT as a 

torisonal bearing, such as nano-motors and nano-switches [9-14], have been fabricated 

and tested in many laboratories around the world. Therefore, the knowledge of the shear 

modulus and the interlayer friction of a CNT is very important in the understanding and 

design of CNT based nano-electromechanical systems that require a fine control of 

actuation and friction between nano-scale objects. 
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A number of investigations have been carried out on the shear modulus of CNTs 

including a few on the interlayer friction within a MWNT. The first measurement of 

MWNT’s shear modulus was reported by Williams et al. in 2002 [15]. A torsional device 

was fabricated on a MWNT deposited on a silicon substrate with a dioxide layer on the 

top and the nanotube was then suspended in air by etching the dioxide layer away 

beneath the nanotube as shown in Fig. 5.1.1. Scanning probe technique with a hybrid 

AFM/SEM was used to investigate the torsional properties. The measured shear modulus 

qualitatively agreed with theoretical values of ~0.5 TPa [3, 16]. Later on, the torsional 

devices were modified into a MWNT and SWNT oscillator for further study on shear 

modulus [12, 17]. The silicon substrate was made to a back-gate by doping of aluminum. 

A small AC signal was added to a DC offset on the back-gate to drive the oscillation of 

metal paddle. An optical interferometer was employed in the SEM to detect and record 

these deflections. Because the resonance frequency is related to the shear modulus by [12] 

2
2

04 4

8

o i

L
G F

r r

 



,          (5.1.1) 

where G is the CNT shear modulus,    is the moment of inertia, L the length of CNT, or

and ir  are the outer and inner radius, respectively and 
0F
 
is the resonance frequency. 

Because the inner radius could not be measured in any event and how much interaction 

would occur between shells was not clear, two limiting models were used to calculate 

shear modulus: eG  the solid rod model and sG the thin shell model.  

In the solid model, all the shells were assumed to twist as much as the outermost 

shell just like a solid rod, while only the outermost shell was torqued in the thin shell 

model. The shear moduli of the MWNTs from 9 devices were calculated based on the 
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above two models. Interestingly, the 
eG of 4 MWNTs agreed qualitatively with the 

experimental values while the 
sG of another 4 MWNTs was in agreement. For one device, 

neither value was close to the experimental value. This indicates that the interaction and 

relative torisonal motion within a MWNT may vary with the number of shells. Both the 

solid rod model and the thin shell model are too simplified to explain the interactions 

between the neighboring layers. 

 

 

Figure 5.1.1 SEM image of an MWNT torsional device. The MWNT is suspended on the 

silicon substrate by etching away the dioxide layer beneath the tube. Scale Bar, 1 μm . 

Image adapted from [15]. 

 

 

Torsional devices built on SWNTs were also fabricated to examine this 

phenomenon for the simplest case [8]. The SWNT pendulum which employed SWNT as 

a torsional bearing with a metal pad was suspended on the silicon substrate by etching 

away the dioxide layer beneath the nanotube. The doped silicon substrate was used as a 

back-gate to actuate the paddle via a bias DC voltage. The deflection of the paddle was 

measured from the change in the projected length of the paddle in SEM images as shown 

in Fig. 5.1.2. The torque applied on the paddle from the electrical static force was 
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calculated from a finite element model with the detailed knowledge of the device 

geometry.  The shear modulus of SWNT was obtained by solving the equation [18] 

1 2

3

1 2( )

l l
G

r t l l







,         (5.1.2) 

where 
1l and 

2l  are the nanotube length to the left and right of the paddle, respectively, r 

is the radius of the nanotube,   is the delfection angle and t=0.34 nm is the wall thickness 

and τ is the net torque. The average value for the SWNT shear modulus of the device was 

0.41 ± 0.36 TPa. No detectable nonlinear response was observed in the experiment. This 

result indicates that the torsional response is linear in SWNT at least before plastic 

deformation occurs. However, the torsional response for a DWNT or a few wall carbon 

nanotube is still to be answered. Meanwhile, the uncertainty of the shear modulus was 

quite large due to a lack of precise measurement on the radii which cannot be measured 

by SEM.  

The interlayer force was measured in a telescoping motion between the 

neighboring layers with the least surface resistance within a MWNT [19, 20]. An arc-

discharge grown nanotube was glued onto the tip of a sample manipulator in the TEM. 

Outer layers of the nanotube were removed by electrical breakdown and the exposed core 

was spot welded to the tip of an AFM as shown in Fig. 5.1.3. When the AFM tip was 

pulled along the tubule direction, the telescopic motion between the neighboring layers 

with the least surface resistance would occur via a self-selecting process. Interlayer 

friction was estimated to be less than 
151.4 10 N/atom measured from the AFM signal.  

However, the measurement actually gave the minimum estimation on the interlayer 

friction since the telescopic motion prejudicially slides between the smoothest layers. The 
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interlayer force among other layers is still unclear. Furthermore, the contact area was 

constantly shrinking during the telescoping motion and this could also affect the 

measurement of the interlayer force.  

 

 

Figure 5.1.2 (a) SEM images of a device from the top view at different back-gate voltage. 

The width of the paddle is marked by the red line. Scale bar 500 nm. (b) Geometric 

relation between apparent paddle widths and deflection angles. (c) Applied back-gate 

voltage vs. measured paddle deflection for a typical device. Dashed lines represent 

quadratic fit to data and maximum angle attainable with this device (   ). Image adapted 

from [8]. 

 

 

To answer this question, one way is to start from the simplest case: using a 

double-wall carbon nanotube (DWNT), to reduce the interlayer interactions to only two 

layers. This chapter will detail the fabrication of DWNT torional devices applicable for in 



93 
 

situ TEM imaging and electron diffraction. The relative torsional motion is applied to 

study the interlayer interactions while keeping the contact area unchanged. We report the 

inner shell’s torsional response to the shear stress applied to the outer shell. The inter-

layer friction is inferred from direct measurements of each shell’s deformation, van der 

Waals interactions between shells, and reliable models of lattice strain.  

        

 

Figure 5.1.3 (a) Schematic drawing of measurement setup. The protruding core of a 

MWNT is connected to an AFM tip. The outer casing is mechanically connected on the 

other end to a Pt wire, attached onto a sample manipulator which is used to induce 

telescoping motion. (b) TEM images of a telescoping MWNT. Figure adapted from [19]. 
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5.2 Experimental Method  

Fig. 5.2.1 shows the schematic of the device used in the experiment (fabrication 

details are discussed in Chapter 3). The paddle actuation is performed in situ in a 

transmission electron microscope (TEM) via a voltage between the paddle and the gate. 

The advantage of the TEM is that we can take nano-beam diffraction patterns of the 

DWNT before and while it is strained. Analysis of these diffraction patterns permits us to 

determine the chiral indices and the detailed structure of both shells and the atomic 

deformation of the shells under strain.  

 

 

Figure 5.2.1 Schematic of the device which is ready for electrical actuation and in situ 

electron imaging and electron diffraction analysis. 

 

Low-resolution TEM images of the paddle as it is actuated are given in Fig. 

5.2.2(B)-(D).  They show deflections of 90°, 117°, and 147° under DC biases 0 V, 40 V 

and 60 V applied to the gate. The paddle’s angular deflection and hence the net strain in 

the outer shell can be measured directly from changes in the projected length of the 
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paddle. For each of these paddle positions, nano-beam diffraction patterns, Fig. 5.2.2(F)-

(H), were recorded from segments on the right or left side of the paddle. Diffraction 

patterns are also recorded for reference on the untwisted segments between the other 

anchors (see Fig. 5.2.2(E)). From the diffraction pattern and the diameter measured in 

direct image mode, the chiral indices       were identified as (56, 2) (37, 18) from 

2 1

1 2

2

2

D Dv

u D D





[21], where

1D , 
2D and 

3D  are the layer line spacings relative to the 

equatorial line for principal layer lines  L1, L2 and L3 (which are due to Bragg 

reflections of graphene (10) , (10) and (11) , respectively). The three lines mark the 

vertices of two hexagons which correspond to the hexagonal diffraction geometry due to 

the top and bottom walls of the nanotube relative to the incident electron beam, 

respectively. Layer lines L4, L5, L6 are higher order Bragg reflections on graphene and 

similarly, form larger hexagons. These lines obey the rules that 
1 2 3D D D   and 

4 1 2D D D   [22], which can be used to solve the chiral indices when certain lines are 

not clear in the diffraction patterns. The diffraction patterns of the other parts of the 

DWNT give the same chiral indices, which imply that the nanotube has the same chiral 

structure across the entire length. Nano-beam diffraction patterns are recorded for each 

strain angle. Similar to the previous electron microscope experiments on nanotubes [7, 8, 

12], we notice an initial paddle actuation that is apparently due to beam induced charging. 

Upon removal of the DC bias, the paddle returns to its initial position. This indicates that 

the strain on the CNT is elastic.  

When the nanotube is uniformly twisted about its axis, the pitch separation of the 

helix will be smaller or larger depending on the handedness of the nanotube relative to 
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the sense of the twist. From measurements of 
1 2/D D under strain, we are able to 

calculate the twist angle of each shell by equation [23] 

 0

/v u

 





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
,         (5.2.1) 

where 0
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u v

u v
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



and 1

2

D

D
   with 1D and 

2D being measured from the electron 

diffraction patterns of the twisted DWNT. The uncertainty of the twist angle is 

0.02 / nm  along the nanotube, and comes from two parts: the resolution limit of 

diffraction pattern images (1 pixel out of 1024×1024 pixel image); the thermally excited 

oscillation of the paddle. Since the thermal oscillation is very small, we can assume that 

the inner shell had no torsional deformation and the torsional spring constant of the 

nanotube axis is only determined by the outermost shell, which is estimated to 

186.85 10  N M  [3]. With the device geometry and the tube diameter, 4.45 nm, the 

amplitude of the oscillation caused by the thermal energy kBT (where kB is the Boltzmann 

constant and T =300 K) is no more than 2o , i.e. 0.003 / nmo
along the tube.  
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Figure 5.2.2 TEM images and electron diffraction patterns of a suspended DWNT. The 

diffraction patterns are colored and marked by black arrows for ease of illustration. (A) 

High resolution TEM image of a typical DWNT employed in our devices. Scale bar, 5 

nm. (B)-(D) TEM images of the paddle as it is actuated. They show deflections of 

90 , 117  and 147 under DC biases 0 V, 40 V and 60 V applied to the gate. Scale bars, 

200 nm. 
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Figure 5.2.2 (continued) (E) Electron diffraction pattern of a non-twisted segment of the 

DWNT. The black letters and red letters mark the diffraction layer lines of the outer-shell 

and the inner-shell, respectively. The two hexagons in black represent the primary 

reflections of graphene (10) , (10) and (11) from the outer shell and they form three 

principal layer lines L1, L2, and L3 above and below the equatorial line, L0. D1, D2 and 

D3 are their respective layer line spacings measured from the equatorial line. The larger 

hexagons in black represent the higher order reflections of graphene on the outer shell. 

The chiral indices of both shells, (56, 2) (outer shell: diameter 4.467 nm, helicity α = 

1.74°) and (37, 18) (inner shell: diameter d = 3.805 nm, helicity α = 18.72°) , are obtained 

from the diffraction data. 
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Figure 5.2.2 (continued) (F) Electron diffraction pattern of the DWNT when the paddle is 

twisted (due to the exposure to the electron beam) under zero bias voltage.  
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Figure 5.2.2 (continued) (G) Electron diffraction pattern of the DWNT when the paddle 

is twisted under bias voltage of 40 V.  
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Figure 5.2.2 (continued) (H) Electron diffraction pattern of the DWNT when the paddle 

is twisted under bias voltage of 60 V.  
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5.3 Device Modeling and Analysis 

Detailed knowledge of the device configuration, paddle geometry, nanotube’s 

twist angles, and DC bias voltages permit us to build an accurate finite element model as 

reported in an earlier work [8] to calculate the external applied torque on the metal paddle, 

as illustrated in Fig. 5.3.1. The total electrostatic torque  on the paddle is given by the 

surface integral:  
2

0

1
e

surface

R ndA 


  , where 
0 is the vacuum permittivity, 

e is the 

surface charge, n is the local unit vector perpendicular to the paddle surface, dA  is the 

infinitesimal surface area on the paddle, and R is the positional vector of dA from the 

DWNT axis as shown in Fig. 5.3.2. For each shell of the DWNT, the shear modulus and 

torques applied on the nanotube have the relation [18]:   

1 2

3

1 2

1
( )

2
i

i

l l
G

r t l l


 



 ,        (5.3.1) 

where G is the shear modulus, i is the ith torque applied on the shell, r is the nanotube 

radius, t is the shell thickness (we use 0.34 nm here), θ is the twist angle of the tube,       

are the nanotube lengths to the left and right of the paddle, respectively. The shear moduli 

of both shells and the interlayer torque can be solved by Eqn. 5.3.1 if θ and the torque 

applied on the metal paddle are known.  

5.4 Results and Discussion 

Table 5.1 summarizes the results from experiments on two devices. Within its 

uncertainty, the twist of the outer shells matches the rotation angles of the paddles. This 

good match proves that outer-shell’s torsion stain is uniformly distributed along the 
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outer-shell because the diffraction patterns were taken along the different parts of tubule. 

More importantly, it assures that the measurements on the torsional movement of the 

inner shell by diffraction patterns are reliable (Therefore, we can use the paddle 

deflection angle from diffraction patterns, 117 measured from the paddle deflection to 

replace the undetermined strain in the outer shell at 40 V below). We notice that the 

calculated outer-shell twisted angles are a bit off the paddle rotation angles. The 

difference might have been caused by paddle vibrations under electron beam which 

induced charging during the long exposure in recording the images. 

Fig. 5.4.1 compares the strain of the inner shell to the strain of the outer shell. In 

contrast to the outer-shell MWNT torsional model (where only outer shell twists under an 

external torque) or the solid MWNT model (where all the shells twists as a solid cylinder), 

the inner shell strains in proportion to the outer shell but by a smaller amount (20% or 

less).  The intercept indicates that the inner shells twist with the outer shells with no 

stiction effect.  

The fact that DWNT (5, 65) (24, 44) has a larger slope than the DWNT (56, 2) 

(24, 44) indicates the stronger interlayer coupling in the former DWNT. This is due to (i) 

the shorter interlayer spacing (0.31 nm in the former DWNT and 0.34 nm in the latter 

DWNT); (ii) larger contact area along the tube axis between the inner and outer shells, 

which is equal to the product of the tube perimeter and the length. As a result, the van der 

Waals interaction is stronger in the former DWNT and its inner shell twists more. 
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Figure 5.3.1 (A)-(B) Map in side view of electrostatic potential calculated by finite 

element method when the paddle is twisted at different angles. (C) Schematic of the 

device geometry in the finite element model. Unit 
610  m

. 
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Figure 5.3.2 Schematic of torques applied on the both shells of the DWNT. The yellow 

curved arrows shows the torques applied on the outer shell, coming from the metal 

paddle and interlayer van der Waals interaction while the red arrow represents the torque 

on the inner shell. 

 

Based on these measurements, we can also calculate the shear modulus of the 

shells, interlayer interaction, i.e. van der Waals potential, and friction for the DWNT in 

device 1, with the help of finite element simulations mentioned above. Plugging the twist 

angles of both shells and the external torques at 40 V and 60 V calculated from finite 

element analysis into Eqn. 5.3.1, the outer shell and inner shell moduli are solved to be 

0.50  0.01 TPa and 0.41  0.05 TPa, respectively, in agreement with the predictions [3]. 

Because the twisted angles and diameter of the outer shell can be precisely measured in 

the TEM, the uncertainty of the outer shell modulus is much smaller compared to the 

values measured in SEM, ±0.36 TPa [8]. The uncertainty of the inner shell is 5 times 

larger due to the larger uncertainty on the measurement of the inner shell twist angles. 

The interlayer torque between the inner and outer shell at 40 V and 60 V are 



106 
 

  185.5 4.0 10  N M   and   188.9 5.0 10  N M   , respectively. If we assume that the 

interaction is uniform along the tube, interlayer forces F, i.e. static friction, between the 

inner and outer shells at 40 V and 60 V are 9 (2.9 2.0) N10    [ 15(3.6 2.4) 10  N/atom  ] 

and   94.7 2.6 N10   
 
[ 15(5.8 3.2) 10  N/atom  ] (calculated from r F    where r is 

the radius of inner-shell and  is the interlayer torque). The difference between the static 

friction forces is due to the different van der Waals interactions at the different torsional 

strains.   

We calculate the work done by friction from the relative torsional displacement  

of the inner-shell and outer-shell from the following equation: 
f s WW W E E   , 

where 
fW  is the work done by friction, W is the work done by the external torque, sE  

is the nanotube strain energy change and 
WE  is the change of van der Waals energy due 

to interlayer interactions. The first term the right side of the equation can be calculated by 

the same finite element analysis method mentioned above and this yields 258 eVW  . 

The second term is calculated to be 253 4 eV by the equation 

4 4 2 2( )( )

4

o i f i

s

r r
E G

L

 


 
   [24], where sE  is the strain energy change of one shell in 

the nanotube, ,f i  are the final and initial twisted angle, or , ir  
are the radius of outer 

shell and inner shell, respectively, and L is the length of the tube. The uncertainty of sE  

is estimated by the upper-lower bound method. Standard Lennard-Jones potential is used 

for the calculation of the total interlayer potential energy
12 6

1 1

4 [( ) ( ) ]
i oN N

p

i j ij ij

E
r r

 


 

    

[25] as shown in Fig. 5.4.2, where i donates an atom in the inner shell and j an atom in 



107 
 

the outer-shell,  and i oN N  are the total number atoms of the inner and outer shells, rij is 

the distance between the ith atom and jth atom. 3.622 meV/atom  and 0.385 nm 

are used here [25] (The upper cut-off distance of Lennard-Jones potential is taken as 5 

times the C-C bond length beyond which the potential is small enough to be considered 

as zero). The change of van der Waals energy from 117° to 147° is 0.37 eV. Thus, the 

work of friction is 4.63 4 eV . This yields an average kinetic friction force, 

92.1 0.9 10  Nkf
  

 
(

152.6 1.0 10  N/atom  ) calculated by 
1

( ) / 2
2

f k i oW f r r   , 

and  is the relative angular displacement of outer shell to inner shell when the paddle 

is rotated from 117  to 147 . This is about 50% larger than the upper-limit value of the 

kinetic friction measured in a telescoping motion in a MWNT [19]. The difference may 

be due to the following two factors: first, the telescoping motion was measured by a 

method that prejudicially slides the layers with the least interlayer interaction within a 

MWNT experiment. Instead, we measure the torsional motion in a DWNT. Second, the 

interaction area never changes in our experiment but it was constantly shrinking in the 

telescoping motion, which further biases the result to lower values. Meanwhile, the work 

of friction ( 4.63 eV , i.e. 580 μeV/atom) can be considered as the energy barrier which is 

needed to initiate and maintain the relative torsional motion of about 30 . The theoretical 

prediction of the energy barriers for an interlayer rotation of the same angle in a DWNT 

(5, 5) (10, 10) are 590 μeV/atom based on the tight-binding plus dispersion model and 

1040 μeV/atom based on the local density approximation [26]. The relative displacement 

of carbon atoms in a rotation motional is larger than that in a torsional motion. If the 

atomic displacement in the latter is considered linear, the total displacement will be half 

of the displacement in the former. Thus, the energy barriers for an interlayer torsional 
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motion in a DWNT (5, 5) (10, 10) are estimated to 295 μeV/atom and 520 μeV/atom, 

respectively. The experimental value is close to (about 12% larger) the theoretical 

prediction based on the local density approximation model. It should also be noticed that 

lattice strain caused by tube twisting could change  and  in the Lennard-Jones model 

and affect energy barrier in the above estimates.  

In summary, two DWNT-based torsion pendulums were strained reproducibly 

from 
o0  to almost 

o180  elastically. The inner shell strained in proportion to the outer 

shell but by only a small fraction (of order 10%), and the degree of frictional coupling 

between the shells was calculated. The DWNT with a short interlayer distance and a 

larger interlayer contact area exhibits a stronger interlayer coupling. This is the first 

detailed measurement of friction with complete atomic-scale characterization of the 

process. These results will be important in the understanding and design of nano-

electromechanical systems that require a fine control of friction and dissipation between 

nanoscale objects. 
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Figure 5.4.1 The inner-shell’s torsional response to the torsional deformation of the outer-

shell of the two DWNT devices we measured in this work. DWNT1: (diameter d = 4.467 

nm, helicity α = 1.74°),  (d = 3.805 nm, α = 18.72°); DWNT2: (d = 5.299 nm, α = 56.33°), 

(d = 4.679 nm, α =39.64°). The horizontal axis is the torsional twist angle (°/nm) of out-

shell and vertical axis (°/nm) is the torsional twist angle of the inner-shell.  
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Figure 5.4.2 Calculated van der Waals energy of DWNT in device 1 as the function of the 

relative twist angle between the inner and the outer shells (the length of the nanotube is 

reduced to 100 nm to simplify the calculation). 
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Table 5.1 Summary of electron diffraction analysis of the DWNT devices measured in 

this work. The second column is the electrode voltage applied to rotate the metal paddle. 

The third column indicates whether the nanotube diffraction pattern is taken at the right 

side or left side of the paddle. 1 2/D D  is the diffraction layer line spacing ratio shown in 

Fig. 5.2.2 1 2( / )D D is the shift of diffraction layer line when the nantobue is twisted. 

Positive sign indicates the layer lines move toward each other and negative sign indicates 

the lines move away from each other. L is the length of the nanotube from the paddle to 

the anchor. ∆θ and TEM are the twisting angle along the tube calculated from the 

diffraction patterns and the rotation angle of the paddle measured in the TEM images, 

respectively. Last column ∆θ/L is nanotube twisting angle per nanometer.  n/a in the table 

indicates that we are not able to obtain diffraction patterns or TEM images of the device 

in that condition.  
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Chapter 6  

 

Revealing the Handedness of Carbon Nanotubes 

by Electron Diffraction 

 

 

 

6.1 Introduction 

In order to determine the properties of a carbon nanotube completely, we need, 

not only the chiral indices, but also the handedness of the nanotube. The nanotube is 

designated as right-handed using chiral indices 0u v  and left-handed by 0v u  . 

Although the electronic properties of a carbon nanotube have proven to be independent of 

their handedness [1-3], the knowledge of nanotube handedness is important in the 

understanding of their spin related properties, such as the interactions with photons [4-8]. 

As mentioned in Chapter 4, STM has shown their capability of telling the 

handedness of a SWNT [9, 10], but it also shows its limitations on the MWNTs, 

especially the inner shell structure.  Electron diffraction, which can be used to determine 

the chiral indices of both SWNTs and MWNTs, cannot tell the handedness due to the 

2mm symmetry (one two-fold axis and two mirror planes) of scattering intensities for the 

right-handed and left-handed nanotube structures, either [11]. However, this symmetry is 
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broken when the nanotube is twisted about its tubule axis. It is then possible to tell the 

handedness of the nanotube from the shift of its diffraction pattern under a torsional strain.  

Liu and Qin reported a theoretical prediction on the shift of diffraction lines for 

both left-handed and right-handed CNT under a torsional strain in 2005 [12]. Meyer, et al. 

reported an experimental observation of the shift of diffraction layer lines of a SWNT 

bearing a torsional strain in 2005 [13]. Fig. 6.1.1 shows how a SWNT is twisted about the 

tubule axis: one end is twisted either clockwise or counter-clockwise about the tubule 

axis while the other end is fixed. If the twisted angle is smaller than the threshold angle 

beyond which buckling will take place and the deformation becomes plastic, the cross 

section of the SWNT can be assumed circular and the total surface area is unchanged. 

Based on these two assumptions, the twisted SWNT (u, v) still consists of u pairs of 

properly-arranged helices just like the untwisted CNT and the axial distance between 

neighboring atoms along a helix keeps the same, i.e. *

0 (60 )a tan    , where   is the 

helical angle and 0 0.246 nma  is the magnitude of the basis vector in graphene lattice.  

But the pitch length of the twisted nanotube becomes * / (1 / 2 )C C   , where C is 

the pitch length of the untwisted CNT and   is the twist angle per nm. From the 

geometry of the twisted CNT projected in the radial direction, as illustrated in Fig. 6.1.2, 

the horizontal movements between the neighboring pair of helices can be derived as [12] 

0

0tan(60 )

a siny

u A

x



 



,         (6.1.1) 

where , x y  are the displacement of carbon atoms and A is the perimeter of the CNT. 

From the CNT diffraction theories described in Chapter 2 and Eqn. 6.1.1, the 

relation between    and the shift of the diffraction layer lines 1 2/D D  is derived as [12] 
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1 2 1 2

1 2

/ /

/ /

D D D D

D D v u


 
 

  
,         (6.1.2) 

where 
1D  and 

2D  are the diffraction layer line spacings measured from the diffraction 

pattern of untwisted CNT, 1D and 2D  are the corresponding layer line spacings measured 

from the diffraction pattern of twisted CNT. The numerator of Eqn. 6.1.2 can be either 

positive or negative depending on whether the diffraction layer lines L1 and L2 move 

toward or away from each other under torsional strain. The layer line spacings D1, D2, 

and D3 in the reciprocal space are inversely proportional to the pitch lengths of the 3 

equivalent sets of helices in the real space, which are parallel to the lattice vectors 1a , 2a

and 1 2a a , respectively. As we can see from the equation * / (1 / 2 )C C   , the new 

pitch length 
*C  will become either longer or smaller dependent on the sign of twist angle 

Δθ. Fig. 6.1.3 shows an example of a right handed helix under torsion. If one end of the 

helix is fixed and the other end is twisted clockwise (counter-clockwise), the pitch length 

will become longer (smaller). The situation is opposite for a left-handed helix. Within a 

carbon nanotube, the two equivalent helices parallel to the lattice vectors 1a  and 1 2a a  

always have the same handedness while the other equivalent helix has the opposite 

handedness. Therefore, D1 and D3 always move in the same direction while D2 moves in 

the opposite direction. As the result, the diffraction layer line ratio 1 2/D D   will decrease 

(increase) for a right-handed nanotube and the ratio will increase (decrease) for a left-

handed one if one end of the nanotube is fixed and the other end is twisted clockwise 

(counter-clockwise). Fig. 6.1.4 shows simulated diffraction patterns of a right-handed 

nanotube (22, 2) when it is twisted          counter-clockwise and clockwise about the 

tubule axis. 
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This theoretical prediction is verified via the torsional devices fabricated on 

SWNTs and DWNTs, in which the CNT diffraction patterns are taken before and while 

the CNTs are twisted. This chapter will detail the experimental results using the torisonal 

devices. 

 

Figure 6.1.1 (a) Schematic showing twisting a carbon nanotube about its tubule axis in 

side-view. (b) Viewed end-on. The circle with arrow in (a) and (b) indicate the nanotube 

is twisted clockwise. Images adapted from [12]. 
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Figure 6.1.2 Radial projection of a SWNT twisted about the tubule axis. The green-lined 

rectangle and the dark-lined parallelepiped are the graphene cut before and after twisting. 

The twisting angle is reflected as the displacement of atoms such as  and x y  in 

graphene. A is the magnitude of the perimeter vector of the nanotube which is 

independent of the twisted angle and 0t ua sin . C and 
*C  are the pitch lengths of the 

constituting carbon helices before and after the nanotube is twisted. Images adapted from 

[12]. 
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Figure 6.1.3 Schematic of a right handed helix which is relaxed, twisted clockwise and 

counter-clockwise, respectively. 
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Figure 6.1.4 (a) Electron diffraction pattern of an un-twisted SWNT (22, 2). (b) The 

simulated electron diffraction of the same nanotube twisted counter-clockwise 

( 1.20 / nm    ). (c) Diffraction pattern of the nanotube twisted clockwise 

( 1.20 / nm   ).  The dark lines on the central line mark the positions of the principal 

lines of the nantoube with or without twisting, respectively. Images adapted from [12]. 
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6.2 Experimental  

Same torsional devices, as mentioned in Chapter 5, are fabricated using DWNTs 

and SWNTs, as illustrated in Fig. 5.2.1. Electron diffraction patterns were first taken 

from the CNT segments without paddle. The chiral indices and the ratio of layer line 

spacing D1 and D2 are derived from the diffraction patterns for reference. Then a DC 

voltage is applied onto the side gate to rotate the paddle and diffraction patterns from the 

twisted CNT are taken simultaneously. The handedness is determined by the sign of the 

change of the layer line spacings, i.e. the ratio of the untwisted layer line spacing less by 

that of the twisted layer line spacing, corresponding to the tubule twist direction. 

A TEM image of the paddle as it is actuated is shown in Fig. 6.2.1(A).  It shows a 

deflection of 147° under the DC bias of 60 V applied to the gate. The paddle’s angular 

deflection and hence the net strain in the outer shell is measured directly from the change 

in the projected length of the paddle. To obtain the net strain in both outer and inner 

shells, a nano-beam diffraction pattern, Fig. 6.2.1(C), was recorded from the segment on 

the left side of the paddle. Diffraction patterns were also recorded for reference on the 

untwisted segments between the other anchors (see Fig. 6.2.1(B)). From the diffraction 

pattern and the diameter measured in direct image, the chiral indices (u, v) were identified 

as (56, 2) (37, 18) from 2 1

1 2

2

2

D Dv

u D D





 [14].  

6.3 Results and Discussion  

        Fig. 6.2.1(C) compares the diffraction pattern of the twisted DWNT to that of the 

un-twisted DWNT. Clearly, the diffraction layer lines L1 and L2 are moving away from 

each other for both shells as expected for a right-handed nanotube when it is twisted 
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counter-clockwise. Fig. 6.3.1 shows the intensity profiles of the diffraction layer lines L1 

of the outer-shell before and while the DWNT is twisted. The red curves are the 

simulated best-fit Bessel function of order 2, which indicates the chiral index for v is 2 

(details discussed in Chapter 2). The overlap between the left side and the right side of 

the Bessel function in Fig. 6.3.1(B) indicates that the vertices of the top and the bottom 

graphene hexagon move away from each other in the plane perpendicular to the incident 

beam. Given that the DWNT is twisted counter-clockwise at the open end (the other end 

is fixed by the metal anchor deposited on the nanotube) looking from the open end, we 

determined that both shells of the DWNT (56, 2) (37, 18) are right-handed.  

 

 

Figure 6.2.1 TEM image and electron diffraction patterns of a suspended DWNT. The 

diffraction patterns are colored and marked by black arrows for ease of illustration. (A) 

TEM image of the paddle as it is actuated. It shows a deflection of 147  under DC bias of 

60 V applied to the gate. Scale bar, 200 nm. 
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Figure 6.2.1 (continued) (B) Diffraction pattern of an un-twisted segment of the DWNT. 

The green and pink arrows mark the diffraction layer lines of the outer-shell and the 

inner-shell, respectively. The two hexagons in yellow and blue represent the primary 

reflections of graphene (10) , (10) and (11)  from the outer-shell and inner-shell, 

respectively. Each of them forms three principal layer lines L1, L2, and L3 above and 

below the equatorial line, L0. D1, D2 and D3 are their respective layer line spacings 

measured from the equatorial line. Layer lines L4, L5 and L6 are due to the higher order 

reflections of graphene from the two shells. The chiral indices of both shells, (56, 2) 

(outer shell: diameter 4.467 nm, helicity α = 1.74°) and (37, 18) (inner shell: diameter d = 

3.805 nm, helicity α = 18.72°) , are obtained from the diffraction data. 
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Figure 6.2.1 (continued) (C) Electron diffraction pattern of the DWNT when the paddle is 

twisted under bias voltage of 60 V. The positions of the diffraction layer lines of the 

DWNT bearing no torsional strain are represented by the vertices of yellow and blue 

hexagons while the diffraction layer lines from the twisted DWNT are marked by the 

pink and green lines. The pink and green arrows clearly show a shift of diffraction layer 

lines under torisonal strain, which is used to determine the twist angle and handedness of 

the nanotube. 
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Fig. 6.3.2(A) and (C) show the paddle actuation of a SWNT torsional device at 

the deflection of 41° via a gate voltage 65 V and the corresponding diffraction pattern, 

respectively. The diffraction pattern of the un-twisted SWNT is taken in the same way as 

mentioned above, from which the chiral indices are determined to be (46, 8), Fig. 

6.3.2(B). From the shift of the diffraction layer lines, the handedness is determined to be 

right-handed.  

Table 6.1 summarizes the results from experiments on all five torisonal devices. 

Within its uncertainty, the twist of the outer shells matches the rotation angles of the 

paddles in devices 1, 3 and 4. For device 2 and 5, they are a bit off each other probably 

due to the paddle oscillation during the long time exposure. From the results of our 

experiment, there is no obvious preference observed on the choice of handedness of 

SWNT and DWNT. DWNTs can be both right-handed, left-handed or mixed. However, 

the number of our samples is quite small. Further experiments need to be done to prove 

this argument. 
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Figure 6.3.1 Intensity profiles of the diffraction layer line L1 from the outer shell of the 

DWNT shown in Fig. 6.2.1. The red curve is the simulated best-fit Bessel function with 

order 2 in which X1 and X2 are the distances of the first and second order peaks of Bessel 

function. The index v is derived to be 2 from the ratio of X1 and X2 in (A) (details 

discussed in Chapter 2). (A) Non-twisted DWNT and (B) Twisted DWNT. 
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Figure 6.3.2 TEM image and electron diffraction pattern of the suspended SWNT. (A) 

Low-resolution TEM image of the paddle as it is actuated. It shows deflection of 43  

under DC bias 65 V applied to the gate. Scale bar, 100 nm. (B) Diffraction pattern of the 

SWNT of the non-twisted segments The two hexagons in blue represent the primary 

reflections of graphene (10) , (10) and (11) from the top and bottom part of the nanotube, 

respectively. 
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Figure 6.3.2 (continued) (C) Electron diffraction pattern of the SWNT when the paddle is 

twisted under bias voltage of 65 V. The positions of the diffraction layer lines of the 

SWNT bearing no torsional strain are represented by the vertices of the red hexagon 

while the diffraction layer lines from the twisted SWNT are marked by the red lines. The 

red arrows clearly show the shift of diffraction layer lines under torisonal strain, which is 

used to determined the handedness of the nanotube. 
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Table 6.1 Summary of electron diffraction analysis on the CNT devices measured in this 

work. D1/D2 is the diffraction layer line spacing ratio.
1 2( / )D D  is the shift of diffraction 

layer line when the nantobue is twisted. Positive sign indicates the layer lines move 

toward each other and negative sign indicates the lines move away from each other. L is 

the length of the nanotube from the paddle to the anchor. Twisting direction refers to the 

direction looking from the free end of the nanotube. / L  is nanotube twist angle per 

nanometer. ∆θ and TEM are the twisting angle along the tube calculated from the 

diffraction patterns and the rotation angle of the paddle measured in the TEM images. 

Last column is the handedness determined from the shift of the diffraction layer lines. 

N/A in the table indicates that it is not applicable.  
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Chapter 7  

Summary and Future Research Direction 

 

 

 

7.1 Summary and Implication 

The research work in this dissertation presents (i) a foundational study on the 

atomic structure and inter-shell friction of carbon nanotubes which work as the source to 

transport NEMS actuation and (ii) a fabrication technique for two nano-

electromechanical systems (CNT electrical transport system and CNT torsional system) 

which provide two versatile platforms for studies of one-dimensional nano-materials such 

as nanowires or types of nanotubes. The geometry of having a freely suspended carbon 

nanotube makes the device capable of in situ electromechanical manipulation and 

electrical resistance measurement on a single nanotube in a transmission electron 

microscope.  

The electrical resistance at room temperature and the chiral indices of SWNTs 

and DWNTs are measured using the CNT electrical transport device. The measured 
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electrical resistivity shows a general agreement with theoretical estimates based on the 

nanotube band gap and thermal excitation of electrons at room temperature. The 

measurements on DWNTs show that the electrical transport only occurs on the outer shell 

of a DWNT even though the entire nanotube is buried beneath the metal probe.  This 

suggests that the inner shell is insulated to the outer shell probably due to the weak van 

der Waals interaction. These results will be of importance to the future applications of 

CNTs as the current carriers in nano-circuit devices and may be expanded to the study on 

the electrical properties of MWNTs. Since the nanotube is suspended in air between two 

metal probes for in situ TEM imaging, this experiment is free of the error resulted from 

the structure deformation of a CNT caused by the van der Waals force between the 

nanotube and the substrate. In contrast, the error becomes severe as the tube diameter 

increases in the STM measurement where the interaction force is present.  

Lattice strain, shear modulus and interlayer friction of a DWNT are measured 

using the second type of device in which an individual DWNT is employed as a torsional 

bearing attached with a metal paddle. This is the first direct measurement on the inter-

shell coupling under an external torsional stress applied on the outer shell, attributed to 

the electron diffraction analysis which allows measurements on the structural 

deformation of both shells. We observed that the inner shell strains in proportion to the 

outer shell but by a smaller amount (20% or less) with no stiction. The interlayer friction 

is also inferred from direct measurements of each shell’s deformation, van der Waals 

interactions between shells, and reliable models of lattice strain. Due to the direct 

measurement on torsional response of inner shell, the shear modulus of inner shell is also 

precisely derived. These results will be important in the understanding and design of 
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nano-electromechanical systems that require a fine control of friction and dissipation 

between nanoscale objects. 

Finally, the handedness of both SWNTs and DWNTs are measured 

experimentally using the CNT torsional device. The shift of the electron diffraction layer 

lines of a nanotube under a torsional strain reveals the handedness of a nanotube. The 

knowledge of nanotube handedness will be very important in the understanding of their 

spin related properties, such as the interactions with photons. 

7.2 Future Applications and Directions 

Besides the electrical properties, torsional properties and interlayer frictions of 

CNTs, there is still a large amount of knowledge to be explored from the present CNT 

devices. Simultaneous measurements on CNT band gaps and chiral indices can be 

realized in the CNT electrical transport device if a low temperature TEM is employed to 

cool the device to 17 K in its liquid helium holder. The electrical transport response of a 

semiconducting CNT to its torsional strain and the CNT chiral structure can be 

simultaneously measured with the CNT torsional device by a modification on the design 

of the device circuit. The transition from elastic to plastic deformation of a CNT may also 

be investigated based on the second type of device by reducing the tube length, i.e. 

resulting in a larger twist angle per nanometer at the same actuation of the metal paddle.  

More importantly, the device fabrication technique presented in this thesis 

provides a versatile platform to achieve simultaneous measurement on structure and 

property of other one-dimensional or two-dimensional nano-materials such as nanowires 

or nanosheets. As long as the nano-material can be individually dispersed on the silicon 
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based substrate, it can be made into both types of devices using the fabrication technique. 

This will be very useful for revealing the causality between material structure and its 

properties. The applications of nano-materials for nano-scale devices can also be 

benefited from these device geometries. 

Last but not least, the suspended CNT device provides a possible way to fabricate 

three-dimensional nano-devices. With the device part fully suspended in air, it is possible 

to fabricate other devices on top or beneath it. While huge challenges exist, this technique 

can be a starting point for trials.  

The work presented in this thesis on the CNT nano-electromechanical devices 

capable of TEM imaging can be viewed as a starting point to the future investigation 

techniques for nano-materials.   

    

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

Appendix I 

Chemical Vapor Deposition for CNT Synthesis 

 

 

 

        The following section includes step-by-step instructions for synthesizing SWNTs 

and DWNTs on silicon wafer coated with a 200 nm silicon dioxide layer for device 

fabrication. All the parameters have been shown highly sensitive to the specific 

apparatuses being used; different systems will result in significant variations in the 

parameters presented here. This recipe is based on the recipe provided by Dr. Jie Liu’s 

group of Duke University. 

 

DWNT Synthesis 

1) Solvent clean and UV/Plasma clean substrates. 

2) Use FeSi2 solution in hexane (0.12mg FeSi2 powders dissolved in 40 ml ethanol 

and diluted to 1/10000), disperse solution over the entire surface and let it 

evaporate very slowly. 

3) Place samples into the tube furnace. 
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4) With air (no gas), anneal the sample at 900 
o
C for 10 min (not including heating 

time). 

5) Hook up gas inlet and exhaust. 

6) Purge the system with Argon at the flow rate of 500 sccm for 15 min at 900 
o
C 

7) Raise the temperature to 922 
o
C. 

8) Turn off Argon, turn on Hydrogen (500 sccm), Methane (1500 sccm) and 

Ethylene (30 sccm) for 10 min growth. 

9) Turn off the Methane and Ethylene. 

10) Turn off the furnace and leave Hydrogen on for purge purpose. 

11) Let the system cool down to 200 
o
C. 

12) Turn off Hydrogen and take out the sample.  

SWNT Synthesis 

1) Solvent clean and UV/Plasma clean substrates. 

2) Use Fe(NO3)3 as the catalyst (5 mg Fe(NO3)3 dissolved in 50 ml IPA and diluted 

to 1/10000) and disperse solution over the entire surface. 

3) Place samples into the tube furnace. 

4) Hook up gas inlet and exhaust. 

5) Purge the system with Argon at the flow rate of 500 sccm for 15 min. 

6) Raise the temperature to 922 
o
C. 

7) Turn off Argon, turn on Hydrogen (500 sccm), Methane (1500 sccm) and 

Ethylene (30 sccm) for 10 min growth. 

8) Turn off the Methane and Ethylene. 

9) Turn off the furnace and leave Hydrogen on for purge purpose. 

10) Let the system to cool down to 200 
o
C 
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11) Turn off Hydrogen and take out the sample.  



 

 

 

Appendix II  

 

Instructions of Carbon Nanotube Based Torsional 

Device Fabrication  

 

 

 

        The following steps include a complete fabrication procedure from a bare wafer to a 

suspended structure which is ready for in situ TEM imaging and electron diffraction 

analysis. The instruction of electron beam lithography, BHF etching and supercritical 

point drying are mostly based on Dr. Adam Hall’s device instruction in his PhD 

dissertation. They are rewritten here for the continuity of the instruction. The instruction 

is written for the following instruments: 

- Kasper UV mask aligner 

- Keithley 2400  sourcemeter 

- Advanced Vacuum Vision 310 Plasma Enhanced Chemical Vapor Deposition 

System 

- Nano Pattern Generation System (NPGS) Software (J. C. Nabity) 

- DesignCAD 

- Balzers Union CPD 020 critical point drying apparatus 

- Samco RIE System, Model RIE-1C  
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- FEI Helios 600 nanolab Dual Beam Focus Ion Beam System 

I. Photolithography for Wafer Back-Etching 

1) Clean wafer and cut wafer. 

1. Dip the wafer into piranha solution for 10 min, rinse with solvents and 

nitrogen dry. 

2.  Cut the wafer into 33 mm   9 mm slices. 

                 2)  Clean room preparation 

                        1. Turn on and the vacuum pump of the photo mask aligner. 

                        2. Turn on the Lamp Start on the lamp power box and turn on the mask     

                         aligner. 

                        3. Turn on the hot plate and set temperature to 115 
o
C . 

                3) Apply resist 

                        1. Set spin coater to 3000 rpm, 60 seconds and acceleration 15. 

                        2. Place one wafer slice (polished side down) onto the spin coater chuck   

                           (with vacuum function on) and cover the whole surface with photoresist  

                           S1813. 

                        3. Start spin-coat and move the wafer to hot plate once finished for 1   

                          minute soft bake. 

                        4. Repeat for all the samples. 

                 4) Exposure 

                       1. Press MASK LOAD. 

                       2. Unload the mask holder and turn off the vacuum by clicking ENTER. 

                       3. Place the mask onto the mask holder and turn on the vacuum by clicking  
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                          ENTER. 

                       4. Press LOAD and load the wafer. 

                       5. Align the wafer to the photo mask by the x and y position knobs located   

                         on the left and right sides of the sample stage. Make sure the six 0.8 mm  

                         0.8 mm squares are right on the center of the wafer.  

                       6. Set hard contact mode, gap=50 μm and exposure time=10 seconds. 

                       7. Expose the sample by clicking EXPOSURE. 

                5) Develop 

                       1. After exposure, take off the sample and dip it into MF 319 Photoresist   

                         Developer for 40 seconds developing. 

                       2. Rinse the sample with water and nitrogen dry.  

                       3. Check the photolithography patterns in the optical microscope in case   

                          the  sample is over or under developed. 

               II. Remove Backside Nitride Film by Reactive Ion Etching (RIE) System 

                1) RIE preparation  

                      1. Turn on the Nitrogen and cooling water. 

                      2. Turn on O2 and C3F8. 

                      3. Turn on the RIE system and click RESET to vent the chamber. 

                      4. Turn off the valves of O2 and C3F8  on the front panel of RIE. 

                2) Sample etching 

                      1. Lift the chamber lid and put a test wafer onto the center of the  

                       sample stage. 

                      2. Click START and turn on GV1 and GV2. 
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                      3. Set the flow rate reading of C3F8 to 4.8 by turning the valve counter- 

                       clockwise once the chamber pressure reaches 12 mtorr. 

                      4. Slowly turn the O2 valve counter-clockwise until the champer pressure  

                         increased by 10 %.  

                      5. Set the RF power to 400 watts and turn on the plasma. 

                      6. Use the phase and load dial to adjust the reflected power as  

                        close to 0 or 1 watt as  possible. 

                     7. Set the etching to be 7 minutes. 

                     8. Click RESET to vent the chamber once the etching is done.  

                     9. Take out the test sample and check it in the optical microscope (silicon  

                        nitride film is removed if the grey bare silicon can be seen). 

                     10. Repeat all the steps for formal samples. 

                3) Remove the photoresist on the samples by sonication in acetone for 10   

                    minutes.  

      III.      Backside Silicon Etching by KOH 

                1) Preparation before etching 

                    1. Pour 150 ml 45 % potassium hydroxide solution into a 500 ml beaker. 

                    2. Pour 300 ml DI water into the beaker and mix the solution thoroughly. 

                    3. Place the beaker on the hot plate, insert the thermal sensor into the  

                      solution  and set the temperature of hot plate to 70 
o
C. (15 % KOH etches  

                      (100) silicon at a rate of 1 μm per min at 70 
o
C. 

                 2) Etching process  

                      1. Place all the samples into the beaker with unpolished side facing up. 
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                      2. Monitor the etching reaction (hydrogen bulbs will coming out on the  

                         bare silicon surface). If there are not bulbs, it means the nitride film is not  

                         etched  through. 

                     3. Check the etch depth under the optical microscope every 20 minutes after  

                        4 Hours etch. The etch depth is the height of the sample stage when the  

                          sample top surface is in focus subtracted by that of the stage when the  

                          etched  surface is in focus. 

                      5. Stopping etching when the etch depth reaches 400 μm . 

                6. Rinse the sample with water followed by solvent clean. 

      IV.       Plasma Enhanced Vapor Deposition 

                  1) Pre-deposition preparation 

                      1. Select “Start Batch”. 

                      2. Choose “RF etchback” recipe from the pull-down menu. 

                      3. Click “Start”. 

                      4. After 45 minutes etchback, Select “Start Batch”. 

                      5. Choose “Silicon Nitride” recipe from the pull-down menu. 

                      6. Set process time to 5 minutes. 

                      7. Click “Start”. 

                 2)  Film Deposition 

                      1. Click “Vent”. 

                      2. Click “Open” when the “Open” option is shown on the screen. 

                      3. Load the sample onto the center of the sample stage with polished side  

                         facing up. 
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                      4. Click “Close”. 

                      5. Click “Pump”. 

                      6. Click “Start Batch” when the pressure less than 
33.0 10  Pa . 

                      7. Select “Silicon Nitride” recipe from the pull-down menu and set time to  

                          3 minutes (deposition rate 7 nm/min). 

                      8. Once the deposition is done, repeat step 1 to 5 to take out the sample. 

                      9. Repeat the step 1-4 of pre-deposition preparation for the etchback. 

                     10. Click “Start Batch”, select “Oxide” recipe from the pull-down menu and  

                           set time to 5 minutes. 

                     11. Repeat step 1-5 to load the samples with polished side facing up. 

                     12. Select “Start Batch”, choose “Oxide” recipe from the pull-down menu  

                           and set time to be 8 minutes (deposition rate 27 nm/min). 

                     13. Repeat step 1-5 to take out the samples. 

      V.      CNT Synthesis on the Polished Sides of the Wafers Followed by the steps in  

                  Appendix I. 

      VI.      Photolithography on Polished Side  

                 1)  Clean room preparation 

                        1. Turn on the vacuum pump of the photo mask aligner. 

                        2. Turn on the Lamp Start on the lamp power box and turn on the mask     

                         aligner. 

                        3. Turn on the hot plate and set temperature to 115 
o
C . 

                 3) Apply resist 

                      1. Set spin coater to 3000 rpm, 60 seconds and acceleration 15. 
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                      2. Place one wafer slice (unpolished side down) onto the spin coater chuck   

                        (with vacuum function on) and cover the whole surface with photoresist  

                         S1813. 

                      3. Start spin-coat and move the wafer to hot plate once finished for 1  

                        minute soft bake. 

                      4. Repeat for all the samples. 

                 4) Exposure 

                     1. Press MASK LOAD. 

                     2. Unload the mask holder and turn off the vacuum by clicking ENTER. 

                     3. Place the mask onto the mask holder and turn on the vacuum by clicking  

                         ENTER. 

                     4. Place the double side alignment wafer chunk into the chunk holder. 

                     5. Turn on the backside microscope by clicking BSA. 

                     6. Align the microscope position until the desired patterns on the mask can   

                      be seen from the right and left microscope and are located in the center of  

                      the screen. 

                     7. Click GRAB to record pattern position image. 

                     8. Press LOAD and load the wafer. 

                     9. Align the wafer to the photo mask by the x and y position knobs located  

                         on the left and right sides of the sample stage. Make sure the two patterns  

                         on the image right fall on the two 0.4 mm   0.4 mm squares etched on  

                         the backside of the wafer, respectively. 

                    10. Set hard contact mode, gap=50 μm and exposure time=10 seconds. 
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                    11. Expose the sample by clicking EXPOSURE. 

                 5) Develop 

                     1. After exposure, take off the sample and dip it into MF 319 Photoresist   

                        Developer for 40 seconds developing. 

                     2. Rinse the sample with water and nitrogen dry. 

                     3. Check the photolithography patterns in the optical microscope in case the   

                         sample is over or under developed. 

                 6) Metallization 

                     1. Deposit 10 nm Cr or Ti and 50 nm Au with thermal or e-beam evaporator. 

                     2. Thickness is important: thickness of photolithgraphy should be less  

                         than that of future ebeam lithography for superior contact to leads. 

                    3. Soak in acetone for at least 40 minutes and sonicate for 1 minute. 

                    4. Solvent clean the samples and check them in the optical microscope. 

      VII.     Fiducials 

               1) Cleave wafer into individual playgrounds. 

                    1. Place wafer, pattern up, on contact paper. 

                    2. Using a glass slide (separated from wafer by another sheet of contact  

                     paper) as a template, make one small (~0.25”) scribe at one edge. 

                   3. Flip sample and place on padded mat, covered by new contact paper 

                       and roll small metal rod over it (so the rod is parallel with the scribe 

                       and motion is perpendicular), pressing until sample breaks. 

                   4. Spray with isopropanol (IPA), Nitrogen dry.  

               2) Tube burning 
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                    1. Set Keithley for 10-20V and test the connection between each adjacent  

                      lead (1-2, 2-3….7-8,8-1). 

                    2. When there is current greater than a few tens of pA, increase the voltage  

                       until the current drop to couple pAs.  

                    3. Stop the current once connection fails. 

                    4. Also check connection between all leads and backgate to ensure no 

                       leakage current- if so, repeat for those connections.  

                    5. Rinse with IPA and Nitrogen dry. 

               3) Initial Imaging 

                   1. Image samples (capture): 

                      - 1 kV, 20uA 

                      - upper detector (column adjust) 

                      - Cond. Lens 1= 1 

                      - 1.3kX magnification 

                   2. Transfer images to NPGS-equipped computer. 

               4) CAD 

                  1. Choose File -> Image ->Load image file and select high resolution image. 

                  2. Open zif_coarsealign file. 

                  On high resolution image: 

                  3. Zoom on scale bar, hit “u”, set crosshairs at ends and input length scale. 

                 4. Hit “v”, draw vectors to symmetrical areas of sample (fine alignment marks),   

                     zoom on intersection, go to Point->Origin and click on intersection point,   

                     and delete vector. 



147 
 

                 5. Copy appropriate fiducials and place them appropriately. 

                 6. Copy coarse align windows onto image and align. 

                 7. Delete SEM background image. 

                 8. Delete devices and fids and NPGS-> Save what remains as *_aln.DC2. 

                 9. Hit Edit -> Undo. 

                 10. Delete alignment windows and NPGS-> Save what remains as *_dev.DC2. 

             5) Run file 

                 1. In NPGS menu, go to Project -> Create New Project, add folder name where  

                     files were stored. 

                 2. In “run file editor”, set entities to 2, change first to alignment and input *-           

                     aln.DC2, input *_dev.DC2 for second. 

                  FOR ALIGNMENT: 

                 3. magnification = 800 

                 4. measured beam current = 12 

                  5 ls=2000 

                  FOR PATTERN: 

                 6. magnification = 800 

                 7. ls=300 

                 8. measured beam current = 12 

                 9. dose= 1.2 

             6) Bylayer PMMA 

                 1. Set spin coater to 5000 rpm and 40 seconds, set hotplate with internal  

                     readout to 180 
o
C and set a timer to 2 min. 

                 2. Using dropper, deposit 4% PMMA (mwt = 350k) onto the sample until  
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                     entire surface is covered but not dripping off edges, start spinning and (once  

                     finished) move to hotplate. 

                 3. Remove after 2 min. 

                 4. Set spin coat to 4000 rpm and 40 seconds, set tube furnace to 180 
o
C. 

                 5. Stick sample, backgate down, to spin coater chuck with two sided tape or   

                     carbon tape. 

                 6. Using dropper, deposit 4% PMMA (mwt = 996k) onto sample until entire  

                    surface is covered but not dripping off edges, start spinning. 

                 7. Bake in tube furnace for 1.5-2 hrs. 

           7)  Exposure 

                 1. Put sample on Faraday cup stage and set SEM for 30 kV and 5 μA and go to   

                    faraday cup. 

                 2. Set focus and stigma on edge of cup. 

                 3. Set current in high mag mode (above 20k x) to appropriate current 

                   (check run file “measured current”). 

                4. Move to playground and refocus on debris or metal edge. 

                5. Set magnification (check run file “magnification”), switch control over to   

                  NPGS and process run file. 

                6. Switch control back to SEM; repeat for all samples. 

         8)  Develop 

                1. Put small amount of PMMA developer (Methyl Isobutyl Ketone (MIBK):  

                  IPA, 1:3) in 10 mL beaker and set timer for 1:10 (make sure it’s enough to   

                   submerge the sample area). 
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                2. Develop each sample, rinse with DI water and Nitrogen dry. 

                3. Check with optical microscope. 

       9)  Metallize 

              1. Deposit ~10 nm Cr or Ti and ~80nm Au with thermal or e-beam evaporator. 

              2. THICKNESS SHOULD BE GREATER THAN THICKNESS OF   

                 PHOTOLITHOGRAPHY. 

       10) Liftoff 

              1. Soak in acetone for at least 15 min. 

              2. Use syringe/sonicator to remove off excess metal. 

              3. Rinse with IPA, Nitrogen dry. 

  4. Check with optical microscope. 

    VIII. Paddles and Anchors 

          1) Image samples. 

              1. Image samples (capture): 

                 - 1 kV, 20uA 

                 - upper detector (column adjust) 

                 - 1.3kX magnification 

                 - transfer images to NPGS-equipped computer 

                 - store samples in acetone for cleanliness (rinse with IPA and Nitrogen dry   

                 before further use) 

           2)  CAD (for each) 

                 1. Choose File -> Image ->Load image file and select high resolution image. 

                 2. Open zif_finealign file and paddle farm file. 

                  On high resolution image: 
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                 3. Zoom on scale bar, hit “u”, set crosshairs at ends and input length scale. 

                 4. Hit “v”, draw vectors to symmetrical areas of sample (fine alignment marks),   

                  zoom on intersection, go to Point->Origin and click on intersection point, and  

                  delete vector. 

                 5. Copy appropriate anchors and paddles (for CNT, generally no longer than  

                    600nm) and place them appropriately. 

                 6. Make electrical leads (make no less than 2μm thick), starting from 

                    anchor and going to lead. 

                 7. Copy fine align windows onto image and align. 

                 8. Delete SEM background image. 

                 9. Delete devices and NPGS-> Save what remains as *_aln.DC2. 

                10. Hit Edit -> Undo. 

                11. Delete alignment windows and NPGS-> Save what remains as *_dev.DC2. 

           3)  Run file  

                1. In NPGS menu, go to Project -> Create New Project, add folder name where  

                   files were stored. 

                2. In “run file editor”, set entities to 2, change first to alignment and input *-  

                    aln.DC2, input *_dev.DC2 for second. 

                 FOR ALIGNMENT: 

                3. magnification = 900 

                4. measured beam current = 12 

                5. layers 11 and 15 = Start New Set 

                6. ls(7-10)=2000 

                7. ls(11-14)=456 
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                8. ls(15-18)=192 

                FOR PATTERN: 

                9. magnification = 900 

                10. ls=300 

                11. measured beam current = 12 

                12. dose= 0.9 (for very small separation distances, values as low as 0.6 can be      

                     used) 

             4) Bylayer PMMA 

                  1. Set spin coater to 5000 rpm and 40 seconds, set hotplate with internal  

                     readout to 180 
o
C and set a timer to 2 min. 

                  2. Using dropper, deposit 4% PMMA (mwt = 350k) onto sample until entire  

                     surface is covered but not dripping off edges, start spinning and (once  

                     finished) move to hotplate. 

                  3. Remove after 2 min. 

                  4. Set spin coater to 4000 rpm and 40 seconds, set tube furnace to 180 C. 

                  5. Stick sample, backgate down, to spin coater chuck with two sided tape or   

                     carbon tape. 

                 6. Using dropper, deposit 4% PMMA (mwt = 996k) onto sample until entire  

                    surface is covered but not dripping off edges, start spinning. 

                 7. Bake in tube furnace for 1.5-2 hrs. 

           5)  Exposure 

                 1. Put sample on Faraday cup stage and set SEM for 30 kV and 5 μA and go to   

                    faraday cup. 
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                 2. Set focus and stigma on edge of cup. 

                 3. Set current in high mag mode (above 20k x) to appropriate current 

                   (check run file “measured current”). 

                4. Move to playground and refocus on debris or metal edge. 

                5. Set magnification (check run file “magnification”), switch control over to   

                  NPGS and process run file. 

                6. Switch control back to SEM; repeat for all samples. 

         6)  Develop 

                1. Put small amount of PMMA developer (Methyl Isobutyl Ketone(MIBK):IPA,   

                  1:3) in 10 mL beaker and set timer for 1:10 (make sure it’s enough to   

                   submerge the sample area). 

                2. Develop each sample, rinse with DI water and Nitrogen dry. 

                3. Check with optical microscope. 

       7)  Metallize 

              1. Deposit ~10 nm Cr or Ti and ~80nm Au with thermal or e-beam evaporator. 

              2. THICKNESS SHOULD BE GREATER THAN THICKNESS OF   

                 PHOTOLITH. 

       8) Liftoff 

              1. Soak in acetone for at least 15 min. 

              2. Use syringe/sonicator to remove off excess metal. 

              3. Rinse with IPA, Nitrogen dry. 

  4. Check with optical microscope. 

   IX HNA Backside Etching 

               1. Turn on hot plate and set temperature to 60 
o
C. 
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               2. Place a large and clean wafer on the hot plate. 

               3. Cut a 5 mm5 mm copper tape and attach it to the sample on the position . 

                  about 0.5 mm higher than the playground. It works as a stop of HNA. 

                  Otherwise HNA will etch the playground along the sample edges during the  

                  backside etching. 

               4. Place samples on the large wafer with unpolished side facing up. 

               5. Place the a drop of HNA into the etched windows on the backside of the  

                  sample to etch the silicon. 

               6. Let the HNA evaporate and repeat step 5 until all the left silicon is etched  

                  away. 

               7. Rinse samples with water and followed by solvent clean. 

   X.  FIB Fontside and Backside Etching 

         1) Frontside etching 

             1. Click  Vent. 

             2. Stick the sample onto the FIB sample stage with double side copper tape. 

            3. Click Pump. 

            4. Turn on electron and ion beam by clicking Beam On on electron and ion beam  

              windows. 

           5. In the SEM mode, move the sample so that the left upper corner of the  

             playground is in the center of the screen at 4k magnification. 

         6. Tilt the sample to 7 
o
 and move the sample feature back to the center of the  

           screen if it moves away during the tilting. 

         7. Tilt the sample back to 0 
o
 and bring the feature back to the screen center if it  
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           moves away. 

        8. Repeat step 7-8 until the shift is less than 10 μm  from 0 
o
 to 7 

o
. 

        9. Tilt the sample to 52 
o
 and move the sample feature back to the center of the  

           screen if it moves away during the tilting. 

        10. Tilt the sample back to 0
o
 and bring the feature back to the screen center if it  

           moves away. 

        11. Repeat step 9-10 until the shift is less than 1 μm  from 0 
o
 to 52 

o
. 

        12. Switch to ion beam mode and align the beam until the same feature is at the   

             center of the screen. 

        13. Select Rectangle from the Pattern menu and draw a 13 μm   13 μm  rectangle in   

            the blank area (no metal leads) and set the etch depth to 550 nm.  (the etched  

             window will be used for the TEM alignment) 

        14. Click Etching button. 

        15. Tilt the sample to 0 
o
 and switch to SEM mode. 

        16. Move the playground center to the screen center. Repeat step 6-12. 

        17. Select Rectangle from the Pattern menu and draw a cross mark (3 μm   0.7 nm)  

            in the blank area (no metal leads) and set the etch depth to 550 nm.  The cross  

            mark will be used as alignment mark in the backside FIB etching. 

        18. Click Etching button. 

        19. Tilt the sample to 0 
o
, switch to SEM mode and scan the playground at the  

             magnification of 1.3 k.  

        20. Record all the coordinates of the devices relative to the cross mark.  

        21. Click Vent and take out the sample.  
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      2) Backside FIB etching 

          1. Flip the sample over and attach the sample to the sample stage. (Make sure the  

            playground window cannot touch anything otherwise it will break. 

          2. Click Pump. 

          3. Turn on electron and ion beam by clicking Beam On on electron and ion beam  

              windows. 

          4. In the SEM mode, move the sample so that the cross mark is in the center of the  

            screen at 4k magnification. 

          5. Tilt the sample to 7 
o
 and move the cross mark back to the center of the  

             screen if it moves away during the tilting. 

          6. Tilt the sample back to 0 
o
 and bring the cross mark back to the screen center if it  

              moves away. 

          7. Repeat step 5-6 until the shift is less than 10 μm  from 0 
o
 to 7 

o
. 

          8. Tilt the sample to 52 
o
 and move the cross mark back to the center of the  

             screen if it moves away during the tilting. 

          9. Tilt the sample back to 0
o
 and bring the cross back to the screen center if it  

           moves away. 

          10. Repeat step 8-9 until the shift is less than 1 μm  from 0 
o
 to 52 

o
. 

          11. Switch to ion beam mode and tilt the beam until the same feature is in the  

              center of the screen. 

          12. Locate the device positions with respect to the cross mark, draw a 1.4 μm   1.9  

            μm  rectangle at the position of every device and set the etch depth to 350 nm.  

            This will leave a 150 nm silicon dioxide film to support the device. 
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          13. Click Etching button. 

          14. Tilt the sample to 0 
o
 and switch to SEM mode. 

          15. Click Vent and take out the samples. 

          16. Check the sample in the optical microscope if the etched windows are right  

               below the devices. 

XI. BHF Etching 

       1)  Image samples 

             1. image samples (capture): 

                - 1 kV, 20uA 

                - upper detector (column adjust) 

              - 1.3kX magnification 

          2. Transfer images to NPGS-equipped computer. 

          3. Store samples in acetone for cleanliness (rinse with IPA and Nitrogen dry before  

            further use). 

      2) CAD (for each) 

            1. Choose File -> Image ->Load image file and select high resolution image. 

            2. Open zif_finealign file and paddle farm file. 

            On high resolution image: 

            3. Zoom on scale bar, hit “u”, set crosshairs at ends and input length scale. 

            4. Hit “v”, draw vectors to symmetrical areas of sample (fine alignment marks),   

              zoom on intersection, go to Point->Origin and click on intersection point, and  

             delete vector. 

           5. Draw line DIRECTLY over paddle (line width = 0.2). 
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           6. Copy fine align windows onto image and align. 

           7. Delete SEM background image. 

           8. Delete devices and NPGS-> Save what remains as *_aln.DC2. 

           9. Hit Edit -> Undo. 

          10. Delete alignment windows and NPGS-> Save what remains as *_dev.DC2 

      3) Run file  

          1. In NPGS menu, go to Project -> Create New Project, add folder name where  

            files were stored. 

          2. In “run file editor”, set entities to 2, change first to alignment and input *-  

             aln.DC2, input *_dev.DC2 for second. 

           FOR ALIGNMENT: 

          3. magnification = 900 

          4. measured beam current = 12 

          5. layers 11 and 15 = Start New Set 

          6. ls(7-10)=2000 

          7. ls(11-14)=456 

          8. ls(15-18)=192 

          FOR PATTERN: 

          9. magnification = 900 

          10. ls=300 

          11. measured beam current = 12 

          12. dose= 0.9 

 

    4) PMMA coating 
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          1. Set spin coater to 4000 rpm and 40 seconds, set tube furnace to 180 
o
C. 

          2. Stick sample, backgate down, to spin coater chuck with two sided tape or carbon  

             tape. 

         3. Using dropper, deposit 4% PMMA (mwt = 996k) onto sample until entire surface               

             is covered but not dripping off edges, start spinning. 

          4. Bake in tube furnace for 1.5-2 hrs. 

     5) Exposure (for each) 

          1. Put sample on Faraday cup stage and set SEM for 30 kV and 5 μA and go to  

            faraday cup. 

          2. Set focus and stigma on edge of cup. 

          3. Set current in high mag mode (above 20k x) to appropriate current. 

            (check run file “measured current”) 

          4. Move to playground and refocus on debris or metal edge. 

          5. Set magnification (check run file “magnification”), switch control over to NPGS  

            and process run file. 

          6. Switch control back to SEM; repeat for all samples. 

   6) Develop 

          1. Put small amount of PMMA developer (MIBK:IPA, 1:3) in 10 mL beaker and  

             set timer for 1:10 (make sure it’s enough to submerge the sample area). 

          2. Develop each sample, rinse with DI water and Nitrogen dry. 

          3. Check with optical microscope (may not be able to see). 

   7) Sample etching 

          1. Pour a small amount of BHF solution into a small Teflon beaker and prepare a  
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            timer. 

          2. Use a plastic syringe, place drops of BHF onto the sample (DO NOT spill over  

            edge- will eat away backgate). 

    8) Etch stop 

          1. Prepare a large beaker of DI water and a storage jar of ethanol. 

          2. Remove working sample at desired etch depth. 

          3. Keep in mind that etch rate may be varied by the presence of materials (cnt, etc)  

            or by contamination from previous imaging- judge accordingly. 

         4. Dip sample directly into DI water (do not let the liquid leave the surface of the  

           sample; keep wet). 

          *IF USING ETCH WINDOWS: soak in acetone for AT LEAST 40 min. to remove  

           PMMA. 

         5. Remove and place in the  jar of ethanol for storage until critical point drying . 

 XIII. Critical Point Drying 

         1. Make sure all three valves on critical point dryer are firmly closed. 

         2. Remove lid and pour ethanol in drying chamber until port hole is high enough to  

            cover samples (judge by eye). 

         3. Place small glass ring (flow protector) into chamber (and off to right), and inside  

           ring put one of the curved-bottom ceramic pieces (broken tube furnace boat). 

        4. Remove sample from jar and put directly into chamber ethanol (again, do not  

           break Surface tension on sample) and place FACE DOWN in curved piece. If all  

          samples don’t fit, ceramic pieces are stackable; close lid. 

       5. Open both tanks of CO2, push “MAINS” 

       6.  Push “TEMPERATURE” and set goal temperature to 15, let chamber cool. 
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       7. Once cooled, open GAS IN knob (on left of machine) slightly and let port hole fill  

         entirely. 

       8. If it is filled to quickly, the turbulence may damage your samples. 

       9. Close GAS IN, open GAS OUT (right side front) several turns and then slowly  

         open METERING VALVE (right side rear) to let liquid drain (do not let liquid  

         level drop to the sample). 

      10. Close both METERING VALVE and GAS OUT and repeat filling process (from  

           “open GAS IN”, above) 4 or 5 times, until liquid is completely clear and all  

            ethanol is replaced. 

       11. Make sure all valves are closed and close CO2tanks. 

       12. Set goal temperature to 45; transition will occur as pressure and temperature rise-  

            watch port hole for it. 

       13. After transition, open METERING VALVE several turns and open GAS OUT  

            very slightly (should only have started to hear the gas coming out). 

       14. Let pressure reduce; DO NOT let condensation occur (caused by letting out gas  

           too fast). 


